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EEE 4134 VLSI I Sessional

EEE 4134 VLSI | Laboratory
Lab O (Introductory Lab)

Logging into Cadence Server, Tool Setup, Cell Library Creation, Introduction
to Custom IC Design flow

Objectives:
e To login, start a shell tool and start the Cadence Virtuoso software
e To learn about PDK and add the PDK library to the Library Manager
e To create a working library and to get familiar with technology
e To be familiar with Custom IC Design flow

Logging in, starting a shell tool, and starting the Cadence Tool Suite

1. Find Desktop shortcut icon for XLaunch. Double-click on it. Click Next, Next, Next, Finish (in
that order) in the windows that pop-up one after another.

PN
{‘ :

7

XLaunch -
Shortcut

After it starts, you will see the Xming icon at the bottom right corner of your Desktop screen.

9:58 AM

= e B 1016

2. Find icon for Putty. Double click on it to open it. ‘Putty Configuration” window will pop-up.

i

putty

3. Select VLSI_LAB under ‘Saved Sessions’ category. Click Load. The window will look like the
following one:

#R PUTTY Configuration X
Category:
I Session Basic options for your PuTTY session
TE"" I_.oglging Specify the destination you want to connect to
_ smina Host Name (or IP address) Port
. i Keyboard
Bl [172.16.16.160 |[22 |
- Features Connection type:
I Window (ORaw (O Telnet C)Rlogn @SSH (O Seral
Appea!ance Load, save or delete a stored session
i i Behaviour
. - Translation Saved Sessions
. Selaction [vLsI_LAB |
Colo.urs Default Settings Load
=1 Connection \.1_5] LAB
Data Sa\fe
- Proxy
.. Telnet Delete
- Rlogin
+- 55H
""" Seral Close window on exit:
O Aways (O MNever (8 Only on dlean exit
About COpen Cancel

Click Open. A Security Alert window may pop-up. Click Yes.

Page 1




EEE 4134 VLSI I Sessional

4. Now you will see a Terminal window which prompts you for login.

‘@ 1721616160 - PuTTY - O >

5. Log in to your workstation using user ID and password. Your user name and your password will
be your student ID. When you are typing your password, the command window will not display
the characters you type in, so make sure you are typing the right password. After logging in to your
account, Terminal window should look like the following:

E# 120105001 @aust:~

6. Type csh and press ‘Enter’ key.
Then type source cshrc_qand press ‘Enter’ key.

The following message will be displayed in the Terminal window:
Welcome to Cadence tools Suite
That means you can use Cadence tools now.

7. Go to your working directory by typing: ed cic

8. Type virtuosos&

A sample command prompt screen is shown below:

9. Virtuoso® Command Interpreter Window (CIW) appears at the bottom of the screen. From
the CIW menus, all Cadence main tools, online help and options can be accessed. In the window
area, all kind of messages (info, errors, warnings, etc) generated by the different Cadence tools
appear. You can also introduce commands.
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[£] Virtuoso® 6.1.6 - Log: fhome/fall16/120105001/CDS.lag - O d
Eile Tools Optians  Help cadence
Loading ci.cxt

Loading ams. cxb l
Wirtuoso Framework License (111) was checked out successfully. Total checkout time was 0. 0&s. EJ
! ~
- i} »
lause L: Pl R:
1] - [

Another window ‘What’s new in 1C6.1.6 Overview’ appears too. Execute File->Close and Do
Not Show Again and this window will not appear the next time you open Virtuoso.

NOTE: You have to perform these steps above in every class where Cadence tools will be used.
The following figure summarizes the steps:

Start XLaunch
v
Start Putty
Open VLSI_LAB session
v
Login to server

v

Type the commands one
by one and press Enter:
csh

source cshrc q
cd cic
virtuosoé&
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Custom IC Design Flow

The following figure shows the basic design flow of a custom IC design, together with the Cadence
tools required in each step:

Design Specifications

v

\Ad

Schematic Entry

v

Simulation

No

Yes

\A4

Layout Design

2

Layout Verification

No

Yes

Parasitic Extraction

v

Post-Layout
Simulation

No /ok?

Yes

Format Conversion
(CIF, GDS 1)

.2

Fabrication

v

Measurements

Cadence
Tools

Virtuoso Schematic Editor L

ADE L (Spectre)

Virtuoso Layout Editor L/XL

Assura DRC and LVS

Quantus QRC

ADE L (Spectre)

First, a schematic view of the circuit is created using Cadence Virtuoso Schematic Editor L.
Then, the circuit is simulated using Cadence Analog Design Environment (ADE L). Different
simulators can be employed; some sold with the Cadence software (e.g., Spectre) some from other

vendors (e.g., HSPICE) if they are installed and licensed.

Once circuit specifications are fulfilled in simulation, the circuit layout is created using Virtuoso
Layout Editor L. The resulting layout must verify some geometric rules dependent on the
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technology (design rules). For enforcing it, a Design Rule Check (DRC) is performed. Optionally,
some electrical errors (e.g. shorts) can also be detected using an Electrical Rule Check (ERC).
Then, the layout should be compared to the circuit schematic to ensure that the intended
functionality is implemented. This can be done with a Layout Versus Schematic (LVS) check. All
these verification tools are included in the Assura software in Cadence.

Finally, a netlist including all layout parasitics should be extracted using Quantus QRC tool, and a
final simulation of this netlist should be made. This is called a Post-Layout simulation, and is
performed with the same Cadence simulation tools.

Once verified the layout functionality, the final layout is converted to a certain standard file format
(GDSII, CIF, etc.) depending on the foundry using the Cadence conversion tools.

Learning fundamentals of PDK and adding PDK library to the Library Manager

Cadence is an Electronic Design Automation (EDA) environment that allows integrating in a single
framework different applications and tools (both proprietary and from other vendors), allowing to
support all the stages of IC design and verification from a single environment. These tools are
completely general, supporting different fabrication technologies. When a particular technology is
selected, a set of configuration and technology-related files are employed for customizing the
Cadence environment. This set of files is commonly referred as a process design Kit.

All VLSI designs start with a Process Design Kit known briefly as PDK. A PDK contains the
process technology and needed information to do device-level design in the Cadence Design
Framework Il (DFII) environment.

Throughout the labs we will use a generic, foundry independent 90nm CMOS mixed-signal process
kit developed by Cadence. We will call it generic PDK 90 nm briefly as gpdk090. A PDK contains
all the necessary design and technology data to successfully design and simulate a VVLSI chip on a
particular foundry. The foundry provides the necessary technological data, design rules, and the
device models. Also PDK contains schematic symbols with all necessary views, as well as device
extraction rules for Layout versus Schematic (LVS) check. It also provides parasitic extraction
rules.

Creating a library and attaching technology to library

All the entities in Cadence are managed using libraries, and each library contains cells. Each cell
contains different design views (the structure is similar —and physically corresponds - to a directory
(library) containing subdirectories (cells), each one containing files (views). Thus, for instance, a
certain circuit (e.g. an inverter) can be stored in a library, and such library can contain the different
logic blocks (basic gates, flip-flops, registers, etc) stored as cells. Each block (cell) contains
different views (schematic, layout, symbol, etc.).
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There are usually three types of libraries:
e A set of common Cadence libraries that come with the Cadence software containing basic
components, such as voltage and current sources, R, L, C, etc. (e.g. analogL.ib).
e Libraries that come with a certain design kit (e.g. gpdk090) and that are related to a certain
technology (e.g. transistors with a certain model attached, etc).
e User libraries; where the user stores its designs. These designs employ components from the
Cadence/design kit libraries.
It is recommended that you use a library to store related cell views; e.g., use a library to hold all the
cell views for a single project (that can involve a complete chip design). In our example, we are
going to create a new library for our design and attach it to desired technology library.

1. In the CIW, execute File >New->Library.

2. The ‘New Library’ form appears. In the name field of the New Library type mylib or any name
of your choice.

X New Library — O >
Library Technology File
Mame mylib| — Compile an ASCI technology file

Directory {nan-library directories) — Reference existing technology libraries

& Aftach to an existing technology library

Do not need process information

Design Manager

Mo design manager setup found

/home£a1116/120105001 /cic

_ Compression enabled

Cancel Defaults Apply Help

3. Select Attach to an existing technology library and click OK. ‘Attach Library to Technology
Library’ window will appear.
X Attach Library to Technology Library — O x

Mesw Libirary mylihb

Technology Library analogLib
awTech M

hasic =
cdsDefTechlLih
gqpdk045

m Cancel Apply Help
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4. Select gpdk090 technology library and click OK. This will be the technology chosen for your
design (that you will employ eventually for fabrication). Now all the designs made in this library
are technology-dependent (e.g., the schematic MOS symbols have by default the model for this
technology, the available layout layers correspond to this technology, etc.).

5. In the CIW, the following message will appear:

Loaded gpdkl80/1ibInit. 11 successfully!
Created library "mylib" as "/home/falll6 120105001/ cic/mylih"
INFO (TECH-150011): Design library 'mylib' successfully attached to technology libracy 'gpdk090°.
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EEE 4134 VLSI | Laboratory
Lab 1

Introduction to Virtuoso Schematic Editor, Creating Inverter schematic,
Performing transient simulation of Inverter schematic, Power and delay
measurement of designed inverter for different process corners

Objectives:
e To learn how to draw schematic of basic logic gates in Cadence Virtuoso
e To learn how to perform transient simulation of logic gates
e To learn about process corners and their effects on delay and power dissipation
e To learn how to measure power dissipation and propagation delay of logic gates

Schematic Entry: Creating a Schematic cell view

In this exercise, you will learn how to enter simple schematic and run a simulation to perform
timing simulation of an inverter designed using gpdk090 technology.

1. In the Command Interpreter Window (CIW), execute File >New>Cellview. Set up the ‘New
File’ form as follows:

Library: mylib, Cell: inverter, View: schematic, Type: schematic, Application: Open with:
Schematics L

M New File - 0 %
File

Litrary ik n
Cell inverter|

e schematic

Type schematic [~ |
Application

Dpen with Schematics L B

— Always use this application far this type of file

Library path file
fhome /£a1116 /120105001 feiccds. 1ib

@ concel | Help

2. Click OK when done. The following window may appear. Click Yes/Always.
X Mext License — O >

ey (iclic-23) License Wiruoso_Schematic_Editor_L ("35100") is not available to run Schematics L
o Would you like to try checking out the license Yiruoso_Schematic_Editor_XL ("35115") instead?
Yes Mo Ahways | Mewer | Help

A blank schematic window for the inverter design appears.

Page 8




EEE 4134 VLSI I Sessional

ﬁ Virtuoso® Schematic Editor L Editing: mylib inverter schematic — O X
Launch File Edit Yiew Create Check Options Window Help cadence
L ) . — e ; A o 0y C P :
= 4 0 @ x QO T, O ¢ BT 7 | Q& ¥ L L »E
~ - I - 1= N B S - I
Havigator 28X — — — —

" Default [~ |8
Q B-

Mame =
= inverter

.....

.....

.....

.....

Property Editor 708 %

.....

.....

mouse L: sch3ingleSelectPi) bl demenl) R: schHikdouseFopUpg)
| Cmd: Sel: 0

12| >

Schematic Entry: Adding an Instance to Schematic
Next, we will create simple schematic of an inverter consisting of an NMOS and a PMOS.

1. To create an instance, you can execute Create= Instance in Virtuoso schematic editor window

or simply use shortcut key “i”. The following window will appear:

f}( Add Instance - O bt
Likrary Browse
Cell

Wi symbol

Mames

o add Wire Stubs at:
all terminals & registerad terminals anly

Array Rows 1 Columns 1

47 Rotate ) Ak Sideways _ _q Upside ann

m _Qancel_ ) Defaults ) _ﬂelp )
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2. Click Browse to select a library component. Another window will show up. Choose Library:
gpdk090, Cell: nmoslv, View: symbol. (Note that while you are doing this, the ‘Add Instance’

form is getting updated as well).

X Library Browser - Add Instance - [m] x X Add Instance - O x
_ Show Categories Library  gpdk090 Browse
Library Cell View Cell moslv
gpdk0s0 nmos1v symbaol View symbol
analogLib mimcap B View ~| Lock | Size | | | Mames
basic ndio ads 19k
cdsDefTechLib auCdl 19k o Add Wire Stubs at
gpdk04s nmosiv_3 aulLvs 19k  all terminals @ registered terminals only
nmos 1v_hvt hspiceD 19k =
gpdkig0 nmos1v_hvt_3 spectre 19k j Array 1 Columns 1
o nmos1v_Iso _symbol || ___sK] .
sample nmos 1v_nat — 42 Rotate | | Ak Sideways | |5 Upside Down

nmoszy - — — =
nmoszv_3 qpdk090_rmoslv
nmosZv_nat
nmoscaply Multiplier 1
nmoscapi1v3 Length 100n M

= — Total Width 120n ¥

[Lib: gpdkoso [Free: 743.39G
Finger Width 120n M
Close _Filters... Display... _Help

3. Make sure that the view name field in the form is set to symbol. After you complete the form,
move your cursor to the schematic window and click left button of mouse to place the component.
After entering the components, click Cancel in the Create Instance form or press Esc keeping
your cursor in the schematic window.

Similarly, add pmos1v cell.
If you place component in the wrong location, press ‘m’ on keyboard, click once on the component
to select it and move the mouse to move the component to your desired location.

4. Now we can adjust the sizes of the transistors by editing instance properties. Left click on the
NMOS to select the component. Then, press “q” to modify its properties, or in schematic editor
window, execute Edit = Properties = Object.

You will update the Library Name, Cell Name, and the property values given in the table below as
you place each component. The inverter design contains the following cells from the following
libraries.

Library Name | Cell Name | Properties/Comment

gpdk090 nmos1lv For NMO, Width=240n (this is 2x the minimum channel width)
gpdk090 pmoslv For PMO, Width=480n

analogLib vdd

analogLib gnd
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For example, while modifying the transistor width for NMOS, set Total Width to 240n, and then
press ‘Tab’ key and the Finger Width will be set to the same value. Click OK.
Repeat this for PMOS to set Total Width and Finger Width to 480n. To deselect any object, press

keyboard command “Ctrl+d”.

Next, instantiate power nets (cell vdd and gnd from analogL.ib library).

X Library Browser - Add Instance - m] X X Library Browser - Add Instance - O X

_| Show Categories _ Show Categories
Library Cell View Library Cell View
analogLib wdd symbol analogLib and symhal
analogLib veed Wiew ~| Lock Size analoglib difistbprobe View ~| Lock Size
avlech WCCS avTech diode .
hasic ¥CCSp symbal_form 13k | |[basic durmimy 3 symbol_xform 13k
cdsDefTechLib cdsCefTechLib fourier
gpdko4s gpdk045 fourierzeh
gpdkogo gpdka3o fracpole
gpdk180 gpdk 180
rylib rmyli gnda
sample wdd_inherit sample gndd

vdda iam

wddd ihis_huffer

vee ibit

veea \dc o i

[Lib: analoglLib [Free: 701.55G LLik: analogLib [Free: 701.55G

_Close _Filters.. Display.. Help , | Close Fitters... | Display... | Help

5. Execute Create = Pin or press ‘p’ on keyboard. ‘Add Pin’ form will appear. Enter the name of
the pin and Direction of the pin. Add all the pins (in, out) to the schematic. For an inverter, gate
input pin (e.g. in) is the input and output pin (e.g. out) at the common node between drains of

NMOS and PMOS is output of the inverter. So,

output for out.

select Direction property as input for in, and

X Add Pin - m| X X AddPin - m| x

Pin Mames in| Pin Mames out

Directian input ﬂ Bus Expansion @ of _ on Direction Ouitpauit ﬂ Bus Expansion & off _ on

Usage gchematic ﬂ Placement ® single o multiple  Usage schematic Placement ® single _ multiple

Signal Type gignal n Signal Type gignal n

Aftach Met Expression: & Mo o Yes attach Met Expression: & Mo o Yes

Froperty Mame Property MName

Default Met MName Default Met Mame

Font Height 0. 0825 Fant Style stick Faont Height 0. 0625 Fant Style \stick

- A7 Rotate - ¥_ih, Sideways_/ f..:? Upside DDWD - Show Sensitivity »> "= 4~ Rotate - MJ&, Sideways_/ f..ﬂ Upside Dowg - Show Sensitivity == "
m _ Cancel ;i Defaults | Help m . Cancel )| Defaults | Help

6. Use Add-2Wire menu or simply press ‘W’ key while staying on the schematic editor to enter
wiring mode / Esc to exit. Click and release left button of mouse to start wire connections and click

again at another point to draw wire connection.
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It is a good practice to periodically save your work by clicking on Check and Save button (the
checkmark button just below the Tools menu). You can also save your work from the drop-down

menu File>Save.
The final schematic looks like the olwin one:

7. Click Check and Save. oA

8. Check CIW for errors or warnings. Some licence warnings may be ignored. If there are no error

or design warning, you should see the following message:

INFO (SCH-1170): Extracting "inwerter schematic®
INFO (SCH-1426) : Schematic check completed with no errors.
INFO (SCH-1181): "mylib irwerter schematic" sawed.
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Netlist Creation and Simulation using Spectre

The following flowchart shows the steps to be executed to simulate a design using ADE L.:

| LaunchADEL |

b

Setup Model Libraries
gpdk090_mos.scs

b

Choose Section
TT_slv

'

| Setup Stimuli |

I

‘ Choose Analysis ‘

L

\ Select Outputs \

v

‘ Save Session ‘

v

| RunSimulation |

1. In the Schematic editor window, execute Launch = ADE L. The following window may appear.

Click Always.
I}{ Mext License

— | >

ey (icLic-23) License Analog_Design_Environment_L ("35200") is not available to run A0E L.
o Would wou like to try checking out the license &nalog_Design_Environment_¥L ("95210" instead?

Yes o

Aliays

Mever Help

Analog Design Environment (ADE) L window will appear.

% ADE L (1) - mylib inverter schematic

- O s
Launch  3ession Setup Analyses  Variables Outputs  Simulation Results Tools  Help CEdEI’ICE
gt @2 5=z & k= & Ed D
: ) fAnalyses 7 >_<| —
Design Wariables HAC
Type | Enakle| Argurients | ooon
ame | Yalue | @
sz
*®
Outpuis 28 O
MameSignal/Expr | Walue | Plot| Save| Save Options | L
N Flot after simulation: (Auto n Plotting made: Replace n

203 | Choose Design ...
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2. Set up the model libraries by executing Setup-=Model Libraries. ‘Model Library Setup’

Window will appear:
X spectrel: Model Library Setup — O x

|Madel File | Sectian |
E- Global Model Files
| Wt techiprocess/gpdk030/ibs 0a2 2/gpdk090/ A modelsfspectre/gpdk090.scs [N
b =Click here to add model file=

3. Click twice on the file name given under Global Model Files. An ash coloured button will
appear.

BN processigpdk0a0dibs. 0az2/gpdkD 3044 /modelsrspectredgpdk0an.scs L JIEE
Click on the button. ‘Choose Model File’ window will appear.

X Choose Model File *

Loak in: LEf‘techfprou:essfgpdeSDfmndelsfspectre ﬂ Q L= E] E]

E Comput gpdk0sn. pef

= 120105 gpdkg0.scs
gpdk030_hipolarscs
gpdk030_capacitor.scs
gpdk030_diode scs
gpdk030_mos.scs
gpdk030_mos_age.scs
gpdk030_mos_is0.505
gpdk030_moscap.scs
gpdk0S0_resistarscs
res_polysn.ya
res_vava

resd_wa.wa
rmoise_wva.wa

DO DO E

-
111

File name: Lamen

Files of type: |* n Cancel
]

4. Select gpdk090_maos.scs from the list. Click Open.

In this model file, there are models to simulate various corners like fast-fast (FF), fast-slow (FS),
typical-typical (TT) etc. These are called process corners, depending on the speed of MOS
transistors (NMOS and PMOS). Refer to the following figure for the definition of process corners:

A
FF
7 SF
[N
(7]
o
>
o
FS
> SS
o
wn
Slow Fast
nMOS
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We will choose the section typical from the Section scroll bar and select the section 'TT_s1v'.
These will enable us to use the TT models of the 1.2 VV MOS transistors. Only one Global Model
File will be defined. Uncheck or delete any other model files that appear. Click OK.

|Model File | Sectian |
=- Global Maodel Files
i W itechiprocessigpdkl90imodelsspectre’gqpdk090_mos scs TT 51w

il |=Click here to add model files

5. Now execute Setup = Stimuli to assign signals to pins of the inverter.
X setup Analog Stimuli — O x

Stimulus Type & Inputs _ Global Sources

i

OFF 1in _.-"'g'ruﬂ.! ‘ii"l:l]_t.a_g'E bit

FY

) ™
@ concel . Apply o Change | Help
6. In ‘Setup Analog Stimuli’ window, select Global Sources. Now you can see global power net
vdd!.
Click on Enabled, Select dc under Function and Voltage under Type. Put a value of 1.2 on the
DC voltage box. The filled up form for ‘vdd!” will look like the one below. Click Apply (clicking

OK will close the window and it will have to be reopened to setup inputs).
X setup Analeg Stimuli - O x

Stimulus Type o Inputs & Global Sources

oM wdd! fgnd! Voltage dc "DC woltage'=1.Z2

Enahled o Function AC n Type  (Woltage n

DC vaoltage 1.2 v

€& conce fpply | Change /| Help

7. Select Inputs. For input pin ‘in’, we have to set a pulse waveform. The following figure shows
the definition of pulse parameters:
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A Voltage

Voltage2|~ — _} — T

|
|
|
Voltagel > I <> < 1P

Delay ! Rise Pulse Width ~ Fall I
Time IH'ne Time >|<

Period Period Time

For setting signal to input pin ‘in’, select Inputs in Setup Analog Stimuli window. Click on
‘Enabled’, select Function: ‘pulse’, Type: ‘Voltage’. Parameters for pulse source will be as
follows: Voltagel = 0V, Voltage2 = 1.2V, Period = 40n, Delay time = 3n, Rise time = 3n, Fall
time = 3n, Pulse width = 20n. Click Apply and then click OK. (Delay, Rise time and Fall time can

also be set at ps ranges for sharp transitions).
X Setup Analog Stimuli - O x

stimulus Type & Inputs . Global Sources =

0N  in Sfgnd! Voltage pulse "Voltage 1"=0 "Voltage 2"

r

Enabled Function (pulse n Type  Moltage n

OC voltage

&C maghitude

&C phase

#F magnitude

FAC maghitude

FAC phase

Yaoltage 1 ]

Yaoltage 2 1.2

Feriod 40n

Delay time In

Rize time an

Fall time an

Pulze width 20n =

@I cancel . apply o Change  Help

8. Now choose the analysis to be done from Analyses 2Choose. Select transient (tran) analysis to
be done. Provide a reasonable value for ‘stop time’ to observe few periods of signals. (e.g.
Analysis: tran, Stop Time: 100n, Accuracy Defaults: moderate). Click OK.
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X Choosing Analyses - ADEL (1) - | *
Analysis & tfran o dC - ac — hoise

o T — SENS - dcmatch o acmatch

— sth o P12 o/ 5[ — envip

o P58 _ pac _ psth _ pnoise

- et — psp o Opss — fpac

— gpnoise o gpsf — qpsp s hb

_ hhac _ hbnoise _ hbsp

Transient Analysis

Stop Time 100x

accuracy Defaults (errpreset)

conservative » moderate _ liberal

_ Transient Maoise

Dynamic Parameter
Enabled v Ciptions...

Cancel Defaults Spply Help

9. Select the output to be plotted by executing Outputs=>To be plotted ?Select on Design in the
ADE window. Schematic editor window will pop up, select ‘out’ and ‘in’ by clicking on the
pins/terminals or selecting from the list on the left hand side as shown in the figure below. When
you select them, you will see colours being assigned to these pins.

Marme - |
= inverter
- (@) NMD (nmosTy)
- (@) PIND (ipin)
=0 PIMT (opim
(@) PMO (pmos1v)
A g L —
-, wddl
- jrnP__0
- =0 autP__1

E_nmos1yet

Property Editor 7.8 X
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10. Your Analog Design Environment window should now look like the following:

L% ADEL (1) - mylib inverter schematic — O e
Launch Session Setup Analyses  Marables Outputs  Simulation Results Tools Help cadence
I =N SRR N=N" =
_ _ Analyses =
Design Yariables Eac
Type | Enahble| Arguments E o
Marme | Yalue 1 tran v 0 100n maderate @
=<
#®
< e - O
Qutputs GEa O
_ MamesSignal/Expr | Value| Plot| Save| Save Options
1 in v = ally I!
z out v o alv

-~ I
L 11

Plot after simulation: @uto K@ Piotting mode: Replace B

2(3) | Enviranment ...

| Status: Ready | T=27 C | Simulator: spectre |

11. Before closing the Virtuoso Analog Design Environment window, it is a good idea to save
design settings in a state file, so we can load it up next time. To do this, execute Session = Save
State and save state name in the ‘Save As’ field as ‘inverter’. Next time you run Cadence, you can
simply load the simulation settings from this file by executing Session - Load State.
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X Saving State -- ADE L (1) - O X

Save State Option & Directory o Cellview

Directory Options

State Save Directory «/ artist_states Browse...

Save As inverter

Existing States

Cellview Options

Library myliky
Cell lnwerter Browse...
State spectre_statel

_Cancel _Apply | _Help

12. Now run the simulation by executing Simulation =>Netlist and Run in the ADE window. The
simulation will run and the output will appear in Virtuoso Visualization & Analysis XL window as
shown below.

1 mylib inverter schematic [

Transient Response SatAprls 14:0

13. Finally, we are going to separate the plots into two sub-graphs. Click on the following icon for
splitting graphs.

i
ey

The final plot should look like the one shown below:
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Definition of rise time, fall time and propagation delay

Three main timing parameters are associated with CMOS devices — rise time, fall time, and
propagation delay. Most often, in discussion with regard to these parameters, the system response
of an inverter is used. The following figure defines rise time, fall time and propagation delay of a

gate with the example of an inverter:
Voltage (in)

A

P Time

~+
e
T
—

~H

Voltage (out) E pLy
A >

P Time
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Referring to the above figure, rise time is the time that it takes to charge the output capacitive load.
Fall time is the time it takes for the output capacitive load to discharge. The rise and fall time are
usually measured from 10% to 90% and from 90% to 10% of the steady state value of a waveform,
respectively.

Propagation delay is the time difference between approximately 50% of the input transition and
approximately 50% of the output transition.

Measuring propagation delay using Waveform calculator

Waveform calculator can be used to perform many different measurements and transformations on
the waveforms displayed in the waveform window. This includes — computing the average of a
waveform (e.g. power) over the entire length of the simulation or in a given period of time, finding
the propagation delay of between input and output signals, or
addition/subtraction/multiplication/division of waveforms, etc.

1. Execute Tools-=>Calculator in Virtuoso Visualization & Analysis XL window. ‘Virtuoso

Visualization & Analysis XL calculator’ window will pop-up:
ErE Virtuoso (R) Visualization & Analysis XL calculator - O X

File Tools Miew Opfions Constants Help cadence

||H In Context Results DB: DmeffaIHEﬂ2E|1IZ|5IZ|I31a’simuIati0n.finver‘[erfspectrefschematicfpsfn k

ot o v | wde _ 5 . 08 ~op oot - mp ] -
»

|H it L if _ idc s — opt o war — ¥nZ | _zp

|| off _ Family _ wave |1 Clip | '::!(\ nﬂ |Append Bkﬁectangular B| @| »

Key ... & X |

| i

4 5 | @

] e i s | a . Pop | fE mey | E.’*‘! i |“P5- e fn. |

0l o+ .| Eﬂ. insert . @ﬂ' M e =
| Stack &%
o

%)

o

Function Panel il
|Special Functions n Q

FM compare dBm  dutyCycle  flip gainklargin iintey loadpull  peakTof
ald compression delay eymGak  fourEval getdsciiwave inl Ishift period_j
abs_jitter compressionRIl deriv evmQpsk  freg groupCelay  integ narmalGG phasehd
average  convolve dft eyedperture freq_jitter  harmonic intersect overshoot phasef
handwidth cross dithh  eyeDiagram freguency  harmonicFreg ipn pavy pow
clip dZa dnl fallTime gainBwProd histogramzD  ipn%Rl peak prms
i I
Function Panel Expression Editor
status area B

13| Trace: fout; Context: shomerfalll 641 20103001/ simulationdnvertersspectre/schematic/pst, Dataset: tra
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2. Select ‘vt’. Go to Schematic editor window and click on input node ‘in’. An expression (e.g.
VT(“/in”)) will appear. Copy the expression.

-yt L J T . wdc o ¥E . 0% . op ot . mp L M 5P

L it L il . idc L s _oopt o war . ¥ne \ 4 2l
|| off _ Family _ Wave | v Clip | r;'}q & Append R Fectanguiar B3| {%’|
Key ... =X ﬁHI,-I-I..J,m..

7 i 3 i

3. In the Function Panel, select ‘Special functions’ and select ‘delay’.

Special Functions n Q,

P Corpare dBm dutyCycle  flip gainkdargin - iintey [oadpull  peakTof
azd COmpression delay evmab  fourEval fetasciiave inl [shift period_j
abs_jitter compressionVRI derivy evimGpsk  freg groupDelay  inteq harmalsE phasekd
average convolve dit eyedperure freq_jitter  harmonic intersect overshoot phaseb
bandwidth cross dfiblhy  eyeDiagram frequency  harmonicFreq ipn pavy oy
clip dZa dnl fallTime gainBwProd histogramZD ipnVRl peak fIrms

4. The following window will appear. Put the expression previously obtained in the field ‘Signall’.
Do the same for output signal ‘out’ to fill in the field ‘Signal2’.

Function Panel
|Special Functions n Q

|Th
|

delay

Signall | vT("/in")

Signal2
Threshold Value1 2.5 Threshold Value 2 2.5
Edge Humber1 1 Edge Humber 2 1
Edge Type 1 either n Edge Type 2 |either
Periodicity 1 1 Periodicity 2 1 -

Ok | Apply | Defaults || Close | | Help

Function Fanel I Stack )

Fill up the rest of the form as follows:

Function Panel (S
|Special Functions n Q
delay

Signall | VT("/in")
Signalz |V T("/out")|

Threshold Value 1 0.6 Threshold Value 2 0.6
Edge Mumber1 2 Edge Mumber 2 7
Edge Type 1 falling n Edge Type 2 rising
Periodicity 1 1 Periodicity 2 1 —

Ok | | Apply | Defaults | | Close | | Help

Function Fanel il Stack J
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5. Click OK. The following expression should appear:

syt R o vdc M5 . 0% ~ opo_oof . mp N 5P wswr o hp
. opt o war

it it idc i5 I MNE Zp Lwp . Od

|
[l Off  Family _ Wave |1 Clip | i!"ﬂ'l E \Append Bhﬂectangular B| @ﬂ =

| Key .. B X] | detayfrwrt vT(vinm, Tvaluel 0.6, 7edgel "falling”, 7nth1 2, 7td1 0.0, Pwiz YT("/out"),
E

L ot L

FI { | 7valuez 0.8, Tedge? "rising”, Tnthz 2, Hd2 nil , 7stop nil, Pmultiple nilf
4 0 f *
1 & d - R

5 Po TR m Mese | PR F e
o e D B n | B | e | TYER SR 5

AN

6. Click on Evaluate the buffer icon. L.
The propagation delay (in seconds) will be displayed in the window.

syt Rl o wdc . ME . 0% ~ op oot . mp N o BP0 ovswr o hp
it ® ) idz 5 . opt o war I MNE P _yp g
|l off _ Family _ Wave | Clip | i!,.q & |Append Bkﬂectangular =| {%’| =
s 8% | 10326-12

7 i 9 i

4 = f

1 Z i - —

Po Bom, m Mese | PR F &
o el B B g B e | EE R 5

Measuring rise time and fall time using Waveform calculator

1. Open the ‘delay’ function window under Waveform calculator in the same way that you
followed for propagation delay measurement. This time both Signall and Signal2 will be
VT(“/out”).

2. Threshold value 1 and 2 should be 0.12 (10% of 1.2 V supply) and 1.08 (90% of 1.2 V supply)
respectively for 10% to 90% rise time calculation. These values should be swapped for fall time
calculation.

3. For rise time/fall time calculation, both the Edge numbers must be the same.

4. The Edge types should be rising for rise time calculation and falling for fall time calculation.
Example: Rise time calculation of rising edge 2 for an inverter:
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delay
Signall | VT{"/out™ - o
Signalz | VT{"/out™ [~ |
Threshold Value 1 012 Threshold Value 2 1.03
Edge Number1 2 Edge Humber 2 =
Edge Type 1 rising n Edge Type 2 rising n £
Periodicity 1 1 Periodicity 2 1
Humber of occurrences |single n Flotprint ws. frigger [
Start1 0.0
Start 2 nil Start 2 relative to frigger n!

OF | Apply | | Defaults || Close | Help

5. Click OK after filling in the form as shown above. The following expression should appear:

R 4 f L [ o ¥E . 0% . op ot . mp L M . 5p
it it . ido s _oopt o var . ¥Ne . Ip
| off _ Family _ wWave | Clip | leﬂ & |Append R Fectanguiar B

Key . &X||709.96-12
7 i 9 {
4 il ] §
1 2 K| =
" Po B Ees w Mse | PR Fo &
ol o+ + ‘l a Efﬁ: in'?el:'t| @:JJ fif= E!‘ [:5]“:!‘ * 1 f% | 2

Power Measurement using Waveform Calculator

In this tutorial, we will compute the average power consumed in a circuit for the duration of
transient simulation window.

1. To do this, make sure that before running simulation you select the Outputs 2Save All option in
ADE L window. ‘Save Options’ window will appear. Under ‘Select power signals to output
(pwr)’ option, put a tick mark in all option. Click OK.

Save Options

select signals to output (save) _ none _ selected _ Ivlpub _ vl & allpub _ all

Select power signals to autput (pwr) __ none _ total _ dewices _ subckts ) all

2. Then simulate the circuit as usual, by executing Simulation =2Netlist and Run.
Execute Tools = Result Browser in ADE L window. ‘Result Browser’ window will appear to the
left side in “Virtuoso Analysis and Visualization XL’ window.
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Browser 78X
| F] mylib inverter schematic £
Append n » SatAprls 14:14:11 2017 1

o | — | |

onfinvenen’spectrefschematicfpsfn |

= finverter/spectrefschematic/pst

Signals Search

L tran

[ tranop

L model

L1 instance

[0 output

[0 designParam‘fals
[ primitives

[0 subckts

[ wariables

n 2 50.0 0.0 20.0 90.0 100

3. Double-click on tran. From the signals list, double-click on :pwr

Browser =

fppend B o »
A % | {1 8]

]nfinuerterfspectrefschematicfpsfﬂ [

B B ..vererizpectre/schematic/pst |
G- [ tranOp
G- (L model
G- [ instance Ly
G- L output
G- [0 designParamyals
M- 3 primitives

Signals Search

& in
MEAD:por @ out

@ Pra0pur & vdd
@ _vinp
(@ _vweddip

4. The waveform display window will show the “:pwr” (the instantaneous power consumed by the
whole circuit) along with “in’ and ‘out’ signals.
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Browser 7 E X
— | 1 mylib inverter schematic [
L L H-‘ ? s eI pOns Sataprls 14:14:11 2017 1

P S i

onfinvenen’spectrefschematicfpsfn (=}

B B . invertersspectre/schematic/pst

Bt [ tranCp

B 3 model

L3 instance

[Ea output

B[ designParamals
B [ primitives

Bt [ subckts

B [ variables

Signals Search

g PRAD: et

® Pr0pwr
@ _vinp
@ _vvddip
& in

& out

& vad

20.0 a0.0 100

5. Now, open Waveform calculator window. The calculator window appears. Make sure the
“Wave” and “Clip” options are selected.

vt oM _ wdc s {05 o op. L ot ~ np
@ i o if _ idc ® ~ opt _ war
_ Off _ Family @ Wave | Clip | ,'j\“/\ & |Append D

6. Now switch back to the waveform window and left click the mouse once on the power
waveform. Then switch back to the calculator window. The buffer window should be filled in as

follows:
ot T o wdo s 0% _ op oot . mp . &h -
[ll b it it ) idc s _oopt o war _J ¥he -
_ Off _ Family & ‘“Wave |g Clip | u"ﬂl' & |&ppend nﬁectangular |
LAY = x| getDataf": pwr" Fresult “tran”)

[

H - L:E‘L_J

1-.',.
P

i I‘UIJ| i R
-l I Hit e | 05 He

1+
b

7. Now select ‘average’ from ‘Special Functions’ Menu.
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\Special Functions B Q,

Fr dutyCycle iintey psd tangent

azd 2 A inl pdbb thid

abs_jitter eymipsk inteq pstddey unityGainFreg
average eyesperure  intersect pzhode Yalue
bandwidth eyeliagram  ipn pefilter wavel sWave
clip fallTime ipn Rl riseTime Hmax
Compare flip loadpull Fins =N
COMpression fourEval Ishift rmstoise mval
compressionRIl freq normal@G  rms_jitter Y

8. The buffer will now look like the following one:

Key ... & x|
T & 1

averay elg etCatal™: e Fresult "tran"jl

9. Click on Evaluate the buffer icon and the average power dissipation in that time window will

be displayed (about 1.838 uW in this example).

| Key ... 8 x| 53aE-6

# Exercises

1. Explain the nature of power consumption curve.

2. Perform SS, FF, SF and FS process corner simulations and compare the power consumption

and propagation delays.
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Appendix: Cadence Virtuoso® Schematic Editor L Shortcuts

Shortcut key Tasks performed
w Add a wire
i Add an instance
p Add a pin
I Add label to a wire
e Display options
q Select an object and press q to open ‘Edit
Object Property’ dialogue box
[ Zoom out
] Zoom in
c Copy
m Move
u Undo
Shift+u Redo
f Fit the entire schematic in the window
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EEE 4134 VLSI | Laboratory
Lab 2

DC sweep, Parametric sweep and Symbol creation of inverter

Objectives:
e To learn how to perform DC sweep and parametric simulation in ADE L
e To learn how to create symbol view from schematic view

DC Simulation and Parametric Analysis in ADE L

1. To open the schematic of inverter, execute File=>Open in CIW. In the ‘Open File’ window,
select the inverter schematic from the list. Click OK.
I>< Open File — O e
File
Likrary hmylih

Cell inverter|
Wienys gchematic
Type schematic

Bronise

s -

Application
Open with  |Schematics L B

_ Abvays use this application for this type of file

Cpen for ® gdit _ read

Libirary path file  /home /£31116/120105001 /cicfods. Likb

ok DTS

2. Schematic editor window will open. Execute File=> Save a copy. In the following window,
change the name of the cell to inverter2. Click OK. Close the schematic editor window and open
the inverter2 cell from CIW.

{}C: Save a Copy - O >
Library Mame mylih

Zell Mame inverterd

Wienw schematic

_Cancel ) _thlp_

3. This time we will perform both DC and parametric simulation at the same time on inverter
schematic. We will obtain the transfer characteristic curve (TCC) of inverter from DC simulation
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and by varying the width of the PMOS transistor; we will observe its effect on transfer
characteristics.

Select the PMOS transistor in the schematic editor window, click ‘q’ and ‘Edit object properties’
window will open. Place w under ‘Total Width’ and press tab on keyboard. The ‘Finger Width’
field will be automatically changed as follows:

COF Parameter Walue Display
kodel Marme gpdk090_pmoslvy
bAultiplier 1
Length 1000 M
Tatal Width w M
Finger Width 1Par ("w") / iPar("fingers") M

4. Place symbol of an instance vdc from analogLib to the schematic. In the ‘DC voltage’ field,
type vin and press tab on keyboard. Connect the voltage source between ‘in’ and ‘gnd!’.

X Add Instance — O *
Likarary znalogLihb Erovese

A ——
Cell wdc
Wiewy
Mames

M Add Wire Stubs at:
« all terminals & registered terminals only

Array Rows 1 Columns 1

42 Rotate Ak Sideways d Upside Down

Foise file name

Mumber of noisesfreg pairs 0

DC woltage vin ¥

5. Now place another instance of vdc on the schematic, in the ‘DC voltage’ field, put 1.2 and
connect it between vdd! and gnd!
The final schematic should look like the following:
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You can remove the ‘in’ pin and ‘vdd’ symbol. Click Check and Save.

6. Execute Launch= ADE L and setup Model Library to gpdk090_mos.scs and section to
TT_slv similar to the way you did in Lab 1.

7. Execute Variables = Edit and ‘Editing Design Variables’ window will open.
X Editing Design Variables -- ADE L (3) — O x

Selected Wariahle DBl Nk

ame | YWalue
Mame |

Walue (Expr)

Add Delete Change

[ et Clear Find

Cellview Wariables | Copy From | Copy To

m _Lancel | Apply . Apply & Run Simulation - Help
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8. Select ‘Copy From’. You will see ‘w’ and ‘vin’ appear in the ‘Design Variables’ window.

Click on ‘w’ and in “‘Value (Expr)’ field, put a default value of 480n. Click Apply. Similarly click
on ‘vin’ and in ‘Value (Expr)’ field, put a default value of 0.6.
M Editing Design Variables -- ADE L (5)

- O >
selected Variable Design Yariables
_ Name Value
e o ! B0om |
5 W 480N
Value (Expri 0.6 2
Add Delete Change
L ’ s 4
I et Clear | Find
L o s s
Cellviews Variables | Copy From | Copy To —
L o g >
Cancel Apply Apply & Run Simulation Help

Then click OK.

9. Execute Analyses = Choose and in the ‘Choosing Analyses’ form, select dc. Click on ‘save dc
operating point’.

10. Under ‘Sweep Variable’, select ‘Design Variable’ and click on ‘Select design variable’.
X Select Design Variable = O X

winn
W

Cancel Help

Select ‘vin’ and click OK.

11. Under ‘sweep range’, select ‘start-stop’ and put a start value of 0 and a stop value of 1.2.
Select ‘Sweep type’ to be ‘linear’ and ‘Step size’ to be 0.01. Click OK.
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X Choosing Analyses -- ADE L (5) - O X
Analysis — fran & dc W/ AC  hnige

Wt A — SENnS  dcmatch o acmatch

— sth o 2 o Ep — anvlp

o pss — pac — pstb — pnoise

—_ — P3p — Hpss w— Hpac

o Opnoise o g o Upsp — hhb

. hhac . hbnoize . hbsp

DC Analysis

Save DC Operating Point L
Hysteresis Sweep

Sweep Yariable

__ Temperatura

» Design Yariahle

_ Component Parameter

YYariahle Mame

select Design Variahle

win

kAodel Farameter

Sweep Range

8 Stan-Stop

— Center-5Span

start 0

Sweep Type

Add Specific Points

Enabled

izancel

Stop

& Step Size

Litear
_n  Mumber of Steps

Diefaults

0. 0]

1.2

Diptions...
_

ApplY Help

12. Execute Outputs = To be plotted and select ‘out’ pin on the schematic.

ADE L window will now look like the following:
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© ¥ ADEL (5) - mylib inverter2 schematic — O b
Launch Session  Setup Analyses Yarables Qutputs  Simulation Results Tools Help cadence
RN SEERT D N =" =
_ _ Analyses ZEx] —
Design Yariables Eac
Type | Enahle| Arguments e
_ Marme | Walue 1 dc v t0 1.2 10m Linear Step Size Start-Stop
1 vin BO0M - (4]

EW 4G0n H:::

b4

8 s O

Outputs 2840
_ MamesSignalExpr | Walue | Plot| Save| Save Options

1 out W = ally W

~ 5
b

r I
S
> Select on Schematic Outputs to Be Plot| P10t after simulation: futo K@ Pioting mode: Replace g

[}
11|:sz| Load State ... | Status: Selecting outputs to be plotted.. | T=27 C | Simulator: spectre ||

Select Netlist and run to simulate a single TCC for the given default PMOS width of 480nm.

13. Execute Tools=> Parametric Analysis. ‘Parametric Analysis’ window will open.

Z: Parametric Analysis - spectre(d): mylib inverter2 schematic - O *

File Analysis Help cadence

Il Ready

= % | o] ¥ U L (o ~ | Run Mode: Sweeps & Ranges Bl Q@ O i |
Wariahle | Walue | Sweep? | Range Type | Start Point| End Point | Step Mode | Step Value

Add Variahle... v FromsTo At

< i I

1 | Delete selected rows

14. Click on ‘Add Variable’. From the drop down menu, select ‘w’. Put From: 240n and To:

720n. Select Step Mode: linear steps from the drop down menu and put Step Size: 120n.
Wariable | Walue | Sweep? | HRange Type | From | To | StepMode | Step Size |
W 4a0n v FromsTo Z40n 7zin Lingar Steps (1200

' o

Click on ‘Run selected sweeps’ icon to start simulation.
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The simulated waveforms will be displayed.

1 mylib inverterz schematic [

[ufis] 0.1 0.z 0.3 0.4 0.5 0.6 0.7 0.8 0.8 1o 11 1z

These transfer characteristics can be further explored to find Noise margin, and inversion voltage
for different widths of PMOS.

15. This parametric analysis option can be saved for later use by clicking on the save icon. =
In the following window, give a name to the configuration file and click Save.

X Save as Parametric File - O x
Loak in: S shomesfalll 6120105001 /cic n = e ) (=]
Comput ame ~ |Size |T5rpe |Date rodified

B 120105 |9 cadence Folder 30 Mar .. 3:35:43

B mylib Folder 5 apr 2.4:30:52
el L] Ll
File name: inverers
Files of type: |Parametric Files (.il) n _cancel

16. Also save the state of the ADE L window.
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# Exercises

1. Show the effect of changing NMOS width on the TCC of an inverter.
2. Perform a parametric analysis in transient simulation to show the effect of changing the PMOS
width on the propagation delay. You are expected to obtain a similar graph as shown below:

) mylib inverterd schematic £

wed Apr 5 14:55:14 2017 1

Setup necessary settings for the delay function in the waveform calculator. Click OK and click on

L

‘Evaluate the buffer and display the results in a table’ icon.

The results should be displayed in a table like below:
% Virtuoso (R) Visualization .. — O *

File Edit ¥iew Tools Help cadence

== =

@ delay(Pwrl WT(in™, Tvaluel. . [E]

_ W | delayi?. e nil |
1 240.0E-3 -Z2921E-12
g d60.0E-3 -174.5E-12
g 460.0E-3 -GV 9E-12
4 G00.0E-3 -19.96E-12 s
5 7Z0.0E-3 39.04E-12 L

3. Some of the propagation delays are negative. Explain why?
4. Explain the change in propagation delay with the change in PMOS transistor width.

5. Obtain the output characteristic curve (Ip vs Vps) and transfer characteristic curve (Ip vs Vags)
of NMOS and PMOS.
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Symbol Creation

In this section, you will create a symbol for your inverter design so that you can use this symbol
view for the schematic in a hierarchical design. In addition, the symbol has attached properties
(cdsParam) that facilitate the simulation and the design of the circuit.

1. Open the schematic of the cell inverter from library mylib.

2. In the schematic editor window for inverter, execute Create =Cellview =From Cellview.
‘Cellview from cellview’ window appears. Click OK.

] Cellview From Cellview x

Library Mame mylih Browse
—

Cell Mame inwverter

From Yiew Mame |schematic n

To Yiew Mame symbol

Tool / Data Type  [schematicsymbol n

<

Display Callview
Edit Options L4

Cancel Defaults Apply Help

In the ‘Symbol Generation Options’ window, you can choose the location of the pins.

Symbol Generation Options

Library Mame Cell Name Wiew Mame
inwerter symbaol
Fin Specifications Attributes
Left Pins in List
e
Right Fins ok Ligt
e
Top Ping List
e
Bottom Pins List
e ——
Exclude Inherited Connection Pins:
& Mone o &l o Only these:
Loadrzave _ Edit &ttributes Edit Labels _ Edit Propetties

m Cancel | Apply Help

Click OK and the Symbol Editor window will open.
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Virtuoso® Symbol Editor L Editing: mylib inverter symbol

[ Lanch Ete Est yew ode Crck Optors Mindow il cadence

[ avigator

Default

[ Property Eator 78 %]

mouse L: mouseSingleSelectPt) M: schZoonF i1 0 03)

3. Click Delete icon in the symbol window, delete the outer red rectangle and green rectangle.

4. Execute Create ->Shape->polygon, and draw a shape similar to triangle. After creating the
triangle, press Esc key.

5. Execute Create »Shape =>Circle to make a circle at the end of the triangle. You can move the
pin names according to the location.

6. Execute Create =»Selection Box. In the ‘Add Selection Box’ form, click ‘Automatic’.

X Add Selection Box - O x

Draw the rectangle to define the selection box
or Click below to create it automatically.

Sutamatic
@I Concel | Help

A new red selection box is automatically added.
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7. After creating symbol, click on the save icon in the symbol editor window to save the symbol. In
the symbol editor window, execute File *Check and Save. Then close the symbol editor window.

Page 39



EEE 4134 VLSI I Sessional

EEE 4134 VLSI | Laboratory
Lab 3

Layout of an Inverter using Virtuoso L

Objectives:
e To create a layout view of the basic inverter circuit from scratch in Virtuoso Layout Editor
e To design the layout keeping basic design rules in mind
e To design cell layout of a constant height for use in hierarchical design

Introduction to Layout, DRC and LVS

Layout is representation of a circuit in terms of planar geometric shapes (e.g. rectangles, polygons)
showing the patterns of metal, polysilicon, oxide, or diffusion layers that make up the components
(resistors, inductors, capacitors, transistors) of the integrated circuit.

When using a standard process (e.g. 45nm, 90nm or 180nm process available in our lab), the
behaviour of the final integrated circuit depends significantly on the positions and interconnections
of the geometric shapes due to parasitic resistances and capacitances contributed by them. While
designing a layout, designer must keep in mind performance (e.g. power-delay product) and size
(area occupied by the chip) criterion.

While designing digital circuits, one usually follows an ASIC design flow, where, the height of
standard cells that are used is the same throughout the cell library, but their widths must vary
according to their logical functions and drive strengths. The following figure shows a generalized
standard cell height concept:

| VDD BUS |
| P-TYPETRANSISTORS |

DIFFUSION SPACING Cell Height
N-TYPE TRANSISTORS \

| GND BUS | |

-

Although we will follow a full-custom IC design flow, we will maintain same cell height
throughout our cell library.
The generated layout must pass a series of checks in a process known as physical verification. The
most common checks in this verification process are:

e Design Rule Checking (DRC)

e Layout Versus Schematic (LVS) checking

e Parasitic extraction and post-layout simulation

Design Rule Check (DRC):

Design Rule Checking (DRC) is the process that determines whether the designed layout of a
circuit satisfies a rules specified by the process being used.

Design Rules are a series of rules (e.g. area, width, overlap, enclosure, extension, spacing) provided
by semiconductor manufacturers which are specific to a particular semiconductor manufacturing
process. Design rules specify certain geometric and connectivity restrictions to ensure that the
process can fabricate the device properly.
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Layout versus Schematic (LVS) Check:

The Layout Versus Schematic (LVS)is the verification step to determine whether a
particular integrated circuit layout corresponds to the original schematic or circuit diagram of the
design. A successful Design rule check (DRC) ensures that the layout conforms to the rules
designed/required for faultless fabrication. However, it does not guarantee if it really represents the
circuit we desire to fabricate. This is why an LVS check is used.

Layout design using Virtuoso Layout Suite L Editor

1. Invoke Virtuoso Layout Suite L Editor from the CIW by executing File >New 2>Cellview.
The ‘New File’ form appears. Fill it in as shown in the figure below:
Cell: inverter, View: layout. Click OK.

File

Library mylib :

Cell irverter|

L= layout

Type (out o
Application

Open with LayoutL |

_ Always use this application for this type of file

Library path file
et fcadence S ICEL1S fshare fcdssetup/ocds. 1ib

_Cancel | Help

2. Click ‘Always’ if the following window appears before Layout window appears.

X Next License — O >

ey licLic-23) License Yituoso_Layout_Suite_L ("35300") is not available to run Layout L.
\(,) Would you like to try checking out the license Viruoso_Layout_Suite_ XL ("35310" instead?

Wil Mo o Always o Mewer | Help

The following window of Virtuoso Layout Suite L Editor will appear.
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Eif virtuoso® Layout Suite L Editing: mylib INVX1 layout - [m| X
Launch File Edit Yiew Create Verify Copnectivity Options Tools Window  Assura Optimize  Help cadence
= @ |4 0 @ X RO = |8 || » |7 » |[|[casic BE &G
l”% 1,.,.5 g - 351% | i’bl -EI El 2 {FiSelectd SelNy:0 Sel:0 Sel{O}0 [X -135950 ¥ 7.2850 dx »
Palette 78X e ——————————————————————————
Layers Fx B

» Valid _ Used _ Routing

Q B-
.Nwell drawing n

A Y A5 M5
Hame | Mis | Sel| B
+ ===

- Layer |Pu.| ¥ | S|

Oxide dny W !\_,
W Oxide_thk dry v
B Poly dry W W
B Firnp dnw o W
[ et dnw o W
(] Mirnp [T
[~ et dry W W
| IRE dnw o W
Il siFrot dnw o W
] cont [T

Objects &)X

Objects A =N

i Instances ~ (=

f----Pins ™ !u

..... Wias ¥ ¥

Chjects Grids

mouse L: mouseSingleselectP]) I deMew() R: _l=xHibdousePoplpg
3(5) | Redo | cmet: |

On the left side of the window, you will find a panel called ‘Layers’. This panel is divided in three
main categories which are: layer color, layer name and layer purpose. The details are described in
the table below:

Color Matches the color in the Editing window. Each layer has its own color and pattern.
Each layer has two colors associated with it: a fill color and an outline color. These
colors can be changed to fit your taste by editing the technology file.

Name The type of layer (Nwell, Oxide, Poly, Metall, etc)

Purpose In gpdk090 the only purpose classifications are: drw = drawing, slot = slot
Drawing is used in layout, slot is used to create a hole for metal stress relief

Verify that the layers display corresponds to the gpdk090 layers shown in the GPDK 90 nm Mixed
Signal Process Specification manual (gpdk090 DRM.pdf).

3. Before starting to design layout, you need to set the layout display configuration. Execute the
following in the Virtuoso Layout Editor: Options=>Display or press ‘e’ on keyboard. Configure
the form as shown in the figure below: You have to set the following parameters only:

Minor spacing 0.01
Major spacing 0.1

X snap spacing 0.005
Y snap spacing 0.005
Display Levels: Stop | 10
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Display Controls
» Open to Stop Level
W fAxes
Instance Origins
» EIP Surround
» Pin Mames
Dot Pins
¥ IMet Expressions
__ atretch Handles
_ Mia Shapes
» Dynamic Hilight
¥ Dragged Object Ghost
_ Traversed instance BBox

<

Mets

access Edges
Instance Pins
Array lconsg
Label Crigins
Use True BBOx
Crogs Cursor
Rove Marme
Row Site

True Color Drag

Transparent Group

__ Selection Hint

kdaximum Drag Level 32

kAaximum Mumber of Drag Figures 500

acroll Percent 25

Instance Drawing kMode

LEIEIDx

Fath Display

LEIDrders and Centerlines n

Set LPP Wisihility D0 not check validity n

Show Mame Of o instance

array Display

., Full Start
— Border
— Source Sitefp

=

o

10|

tmaster . hath

Display Levels
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Grid Controls
Type & none o dotz o lines

Dim kajor Dots

kinar Spacing 0,01

kajor Spacing 0.1

¥ Snap Spacing 0. ons

Y Snap Spacing 0. ons

Filter

Size A Style empty n
Snap Modes

Create orthogonal n

Edit orthogonal n

Dimiming
Enable Dimming
SCDPE nane
Drim Grid Lings

Sutomatic Dimming [

Diim Intensity:
a0

Ditn Selected Object Content

True Color Selection only

& Cellview o Library . Tech Library o File

Save To

Load From

«/ cdsenwv

Bronvse. .

Delete From
-

L - L

Defaults Help

Apply

4. Now we are going to build the layout of the inverter. An inverter has an NMOS and a PMOS
transistor. First we will build an NMOS transistor.
Layout of NMOS inverter consists of oxide, Nimp, Cont and Poly layers. Study the rules of these
layers and calculate the minimum size of the Poly, Cont, Oxide and Nimp layer to create an NMOS

transistor.
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The rules related to the NMOS transistor can be summarised as follows:

Contact size

0.12 um x 0.12 um (Fixed)

Poly width (Minimum)

0.1 um (Fixed MOS gate length)

Contact to poly spacing (Minimum)

0.1 um

Contact to oxide enclosure (Minimum)

0.06 um

Poly/Nimp extending from oxide (Minimum)

0.18 um (gate side enclosure)

Nimpenclosing oxide (Minimum)

0.14um (enclosure other than gate sides)

Minimum Metal 1 width

0.12 um

Maximum Metal 1 width

12.0 um

Minimum Metal 1 to Contact enclosure

0.06 um (on at least two opposite sides)

The following figure illustrates some of the design rules mentioned above:

| Io.lsu 3
o 006s] | odde |
LA 0.1u gy
1 ! Cont B Ip | ‘
— e O q N
10.14;11 0.1u) & (0.1p i 10.14;11
e S Bl
‘ Nimp/Pimp IO.].S,U

Now study the PMOS transistor structure in the GPDK 90 nm Mixed Signal Process Spec. The
PMOS transistor consists of Oxide, Poly, Pimp, Cont and Nwell layer. Study the rules of these
layers and calculate the minimum size of Poly, Cont, Oxide, Pimp and Nwell layer to create a
PMOS transistor. The rules related to PMOS are same as NMOS except the there is an additional

layer, the Nwell, whose rules are as follows:

Minimum Nwell width 0.6 um
Minimum Nwell spacing to Nwell (same potential) 0.6 um
Minimum Nwell spacing to Nwell (different potential) 1.2 um
Minimum Nwell spacing to N+ active area 0.3 um
Minimum Nwell spacing to P+ active area 0.3 um
Minimum Nwell enclosure to P+ active area 0.12 um
Minimum Nwell enclosure to N+ active area 0.12 um
Minimum N+ Active Area to P+ Active Area Spacing 0.16um

Now we start building the NMOS and PMOS transistor layout. Look at the LSW and find the

current drawing layer.
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5. Click on the following icon in Virtuoso Layout Suite L Editor window so that it notifies you
anytime you make a violation of any design rule. When clicked, it will show ‘DRD Notify ON’.
DRD stands for Design Rule Driven.

1's

-

6. Select ‘Cont (drw)’ (contact) layer from the ‘Layers’ panel and draw a rectangle of ‘Cont
(drw)’ layer using Create »Shape 2*Rectangle or simple pressing ‘r’. Press ‘ESC’ to stop ‘Create
rectangle’ tool. In gpdk090 technology, Cont layers must be of dimension 0.12 um x 0.12 um. So,
if your rectangle is not of that dimension, click on the rectangle, press ‘q’. In the following

window, check if the criterion has been met and change ‘Width/Height’ if required.

X Edit Rectangle Properties - O et
< = Apply Comman
Attribite Connectivity Farameter; Froperty RO
Layer . n Layer Filter
Left -9.92 Bottom 1.935
Right -9 Top z.055
Width 01z Height 01z

m _ancel ) Apply | Help

Contact to poly spacing must be 0.1 um in this technology and the channel length of
NMOS/PMOS in our design is 0.1 gm. So, we need a minimum space of 0.3 um between the
contacts at source and drain.

7. Press ‘K’ to invoke the ‘ruler’ tool. Use it to measure lengths whenever needed. To copy, press
‘c’. After placing two contacts, the layout looks like this:

8. Now, contact to oxide spacing is minimum 0.06 um. So, draw a rectangle of ‘Oxide (drw)’
layer so that it covers both the contacts and extends from each side by 0.06 um.
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While drawing this, you will see Design rule violations when they are committed.

0.1 0.15 ne

NN
minExtensionDistance 0.06

minArea 0.06

050 06

10. Now we will draw ‘Nimp (drw)’ layer, which must extend from the oxide layer by a minimum
of 0.14 um. First, draw a rectangle and then extend it to meet design rules. Use stretch tool by
pressing ‘s’. Layout will look like the following:
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11. Now, copy it and create another copy of all these layers by selecting all and pressing ‘C’.

12. Click on the ‘Nimp (drw)’ layer of the copy in the upper portion of the layout and press ‘q’ to
edit properties. From ‘Edit Rectangle Properties’ window, select ‘Pimp (drw)’ layer under
‘Layer’ option. Click OK.

X Edit Rectangle Properties — O >
= = Apply Caomman
Attribute Connectivity Farameter Property ROD
Layer -Pimp i — n Layer Filter
Left -1012 Eottom a6
Right -9.18 Top 41z
Width 0.94 Height 0.5e

_cancel . Apply | Help

13. With more metal layers available in today’s silicon processes, using the routing approach, such
as first metal traverse vertically and second metal traverse horizontally, would be advantageous in
standar cell physical design. Using this method, the second layer (e.g. Metal2) can be used for
power and ground routing over internal standard cell transistors. In standard cell layout, it is
preferable to use firt conducting layer, such as Metall, as much as possible to make internal
connections of NMOS and PMOS transitors within the cell. If there is a nedd to use other
conducting layers, such as, Metal2, use of such layers must be kept to a minimum. It is desired to
use first routing (e.g. Metall) layer for standard cell ports.

Our cells will have a height of 5 um. Place the two parts (NMOS and PMOS) 2 um apart, and
create a ruler so that the cell height can be checked whenever needed and the separation between
the NMOS and PMOS can be maintained properly. Now, the layout will look like the following:
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14. Next, draw a ‘Poly (drw)’ path by selecting ‘Poly’ layer from the ‘Layers’ panel and pressing
‘P’ to invoke ‘create path’ tool. This layer must be of 0.1 um in width and in between the two
contacts, extending from the oxide layer by 0.18 um (at least, on both sides). After placing the
‘poly’ gate, the layout will look like the following one:
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15. Now that you know most of the shortcuts and layers, draw contact for body terminals for
NMOS and PMOS. These portions should consist of Cont, Oxide and Nimp (for body of PMOS) or
Pimp (for body of NMOS). Check DRD notifications for design rule violations. The following
figure shows a Psubstrate and an Nwell contact. The measurement dimensions are shown only on

the left one, as they are same for both contacts.
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16. Connect the Drain regions of the NMOS and PMOS. Also connect the source of both MOS’s to
respective body terminals using ‘Metall (drw)’ layer. Connect the drains of the MOS’s using
‘Metall (drw)’ layer.

17. PMOS should be in ‘Nwell (drw)’. So draw an ‘Nwell (drw)’ rectangle surrounding both the
PMOS and the body contact for PMOS. The layout will look like the following:
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18. Now, we have to place pins. The gate is in ‘poly (drw)’ layer. Let’s bring it to ‘Metall(drw)’
layer by extending the ‘Poly (drw)’ layer, creating a contact between ‘Poly” and ‘Metall’ layer by
pressing ‘0’ to ‘create via’ and selecting ‘M1 POV’ under ‘via definition’ and placing it on

layout. _
X Create Via = O >
tode & Single o Stack o &uto
Options —  Compute From Shape(s
p p pes)
Met Mame |
— Create as ROD Chject Marme wial

Yia Definition  |k1_FPOw n i Standard Via / gpdk090

Save Wia Variant

System lzer defined Cut pattern Array pattert

Reset Parameters to .. n

Justification centerCenter n ¥ Yoo
Cut

Cut Class  None Width 0,12 % Length 0.12

Rows 1 B Row Spacing 0.14

Columns 1 B ;—)f Column Spacing 0,14 ‘:-)’
Enclosures
¥ Compute Show Enclosures
Sk Rotate | | il ¥ Sideways | | %Upside Down
m Cancel Help

19. Also draw a ‘Metall (drw)’ rectangle on the via, because the default Metall rectangle area is
less than the required minimum.
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minfrea 0.07

20. Now, Execute Create -=2Pin to create pins for vdd!, gnd!, in and out.

For in, vdd! and gnd! select ‘input’ as ‘I/O type’ and for out select ‘output’ as ‘I/0O type’. Now,
draw rectangles on the Poly-Metall via for ‘in’ pin, PMOS source-to-body ‘Metall’ connection
for ‘vdd!” pin and NMOS source-to-body connection for ‘gnd!” pin. For ‘out’ pin, draw the
rectangle on the Metall layer connecting the two drains of MOS’s.
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kAoe

Connectivity

Terminal Mames

_ Keep First Mame

__ Create Label

_ Create as ROD Ohject
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- O x
& danual _ Auto
& Strong o Weak
in wdd! gnd! — Physical Qnly
# Pitch 0 ¥ Pitch 0
Dptimrs...

Hame rectl
Fin Shape & rectangle o dot o polvgon o circle
If2 Type & input o output o inputOutput o switch
 jumper o unused . tristate
Snap Maode orthogonal n

Arcess Direction

¥ top # hottom o left & right

» any _ naone

Help

You may add label to pins.

21. Finally, add Metal2 paths of 0.5 u width for power rails and connect them to power nets in
Metall by using Metall to Metal2 via by invoking ‘create via’.
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The final layout will look like the following:
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Creating Body ties

Now you know what body tie is. We will now make two instances for body ties one for Psub and
one for Nwell.

1. Execute File 2New =>Cellview and fill in the New File form as follows. Click OK.

X Mew File - O X
File

Library fhylity [~

Cell M1 PSUE|

Wieny layout

Type layout -]
Application

Dpen with Layaut L [~ ]

_ &bways use this application for this type of file

Library path file
sfhome /£21116,/120105001 fcic/cds. 1ib

m ) Cancel o\ Help )

2. Draw psubstrate contact in the same way as you have made it in Lab3.

3. Save it and make nwell contact similarly (name it M1_NWELL), just change the Pimp layer to
Nimp and everything else is the same.
Save these two for later use.
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Appendix A (Shortcut keys for Cadence Virtuoso ® Layout Editor L)

Shortcut Key Tasks performed
f Fit display to window
r Draw rectangle
Edit property of an object
Makes a min width path of the layer
selected in LSW
Ctrl+a Select all
Ctrl+d Deselect all
Cc Copy
m Move
S Stretch side of a rectangle
K Invoke ruler tool
Shift+k Delete all rulers
[ Add an instance
u Undo
Shift+u Redo
e Display options
0 Add via between layers
I Create a label
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Appendix B (gpdk090 Design Rules Guide (Abridged Version for VLSI-I Lab))
Terminology Definitions

Spacing - distance from the outside of the edge of a shape to the outside of theedge of another
shape.

K 7

Enclosure - distance from the inside of the edge of a shape to the outside of theedge of another
shape.

Overlap - distance from the inside of the edge of a shape to the inside of the edgeof another shape.

Butting - outside of the edge of a shape touching the outside of the edge of anothershape.
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Appendix C (Some Most Commonly Violated Design Rules for gpdk090 technology)

Description Value
(For metals k=2 to 6, for vias k=1 to 6) S\L/lrrlglr%ye?
applicable

Minimum oxide (active) area 0.06
Minimum 1.2V N/P Channel gate length 0.1
Minimum poly interconnect width 0.1
Minimum gate/poly interconnect space 0.12
Minimum N/P-channel gate extension beyond active area 0.18
Minimum poly interconnect to related/unrelated active area space 0.1
Minimum poly interconnect area 0.1
Bent gate is not allowed
Minimum N+/P+ implant width 0.24
Minimum N+/P+ implant space 0.24
Minimum N+/P+ implant to active area enclosure 0.14
Minimum N+/P+ implant to gate side enclosure 0.18
Minimum N+ to P+ active area (inside Nwell) spacing 0.16
Minimum N+/P+ implant area 0.15
N+ implant is not allowed over P+ implant
Minimum P+ to N+ active area (outside Nwell) spacing 0.16
Maximum and minimum Contact width/length 0.12
Minimum Contact to Contact spacing 0.14
Minimum Contact on Active Area to gate spacing 0.1
Minimum gate Contact to Active Area spacing 0.12
Minimum Active Area to Contact enclosure 0.06
Minimum Poly to Contact enclosure 0.04
Minimum Poly to Contact enclosure on at least two opposite sides (end of line) 0.06
Contact on gate is not allowed, Contact must be covered by Metall and active
area/poly
Minimum Metal 1 width 0.12
Maximum Metal 1 width 12
Minimum Metal 1 to Metal 1 spacing 0.12
Minimum Metal 1 to Contact enclosure 0
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Minimum Metal 1 to Contact enclosure on two opposite sides of the Contact 0.06
Minimum Metall area 0.07
Minimum Metal k width 0.14
Maximum Metal k width 12

Minimum Metal k enclosure of Via k-1 0.005
Minimum Metal k enclosure of Via k-1on at least two opposite sides 0.06
Minimum Metal k area 0.08
Minimum and maximum Via k width 0.14
Minimum Via k to Via k spacing 0.15
Minimum Metal k to Via k enclosure 0.005
Minimum Metal k to Via k enclosure on at least two opposite sides of Via k 0.06

Minimum of four Via k with spacing <= 0.30um or nine Via k with spacing <=
0.60um are required when connecting Metal k and Metal k+1 when one of the
Metals has a width > 1.0um at the connection point

Minimum Nwell width 0.6
Minimum Nwell spacing to Nwell (same potential) 0.6
Minimum Nwell spacing to Nwell (different potential) 1.2
Minimum Nwell spacing to N+/P+ Active Area 0.3
Minimum Nwell enclosure of N+/P+ Active Area 0.12
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EEE 4134 VLSI | Laboratory
Lab 4

DRC, LVS, RCX and Post-layout simulation of an inverter

Objectives:
e To perform Design rules check (DRC), Layout vs. Schematic check (LVS) of inverter
layout

e To extract parasitic resistance and capacitance from layout of designed inverter
e To perform transient simulation of extracted view
e To create layout views for body ties of NMOS and PMOS for further use

DRC Rules check by Cadence’s ASSURA

1. Now we would like to check the DRC rules by ASSURA. Execute Assura->Technology. In the
following window, type the path of ‘Assura Technolgy File’ as shown. Click OK.
X Assura Technology Lib Select — O =

assura Technology File ftech/process//qpdk090/assura tech. Lib| Wieny | Edit.

o - -

_ Cancel . Apply | Defaults | Help
2. Execute Assura-Run DRC. A DRC window appears as shown below. Fill the form as indicated

in the picture.
Give a Run name. Select ‘gpdk090’ under ‘Technology’. Then click OK.
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[ Run Assura DRC x

Layout Design Source  DFII n Compare two layouts | \(Generate Lyl Compare Rules..

Library mylib Cell inwerter Yiew  layout Browse...

Save Extracted Yiew _ Wiew Mame  dre extracted

&rea To Be Checked (Full n

Run Mame drel Run Directory
S

Run Location lacal n
Yiew Rules Files ¥  Technology gpdk03o n Rule Set | default n

—| Rules File fuet fcadence Agpdk090 wd . Efassuradoe. rul Wi Reload
awitch Mames set Switches
— R&F Include YIEw.
Wariable Walue Default Description
Mone n
Yiew avParameters hAodify avFarameters... g avParameters are set.
WYiew Additional Functions L Mo additional functions are set

Enable limitDrcCheck

m Cancel Apply Defaults Load State Save State Yiew REF Help

3. A DRC completed window appears as shown below, after completion of DRC run:

X Run'drc1” from. hasc.. — O x

The DRC run "drc1” from
“fhomesfalll 6120705001 /cic™

@ has completed successully.

Do you weant to wiew the results of this run®

Yes ] Help

Click Yes.

4. ‘Error layer Window’ (ELW) appear as shown below with INVX1 layout window which shows
the errors.
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X Error Layer Window - O *
File %iew Error-Visihility Show Error by Help cadence
[2] W1A1.30: Wetall must connect to Metal2 with == 2 Wial spaced < 0.30 um 0 _Signof 0 _Fixed
Rules Filter: I3y Y Lolel 4+ Cell Filter: & G S

2 [2] VIsT K12 Metall must connect to Metalz with »= 2 Vial spaced < 0.30 ... |2 | INVET layout mylib
[2] MItAP E.4: Mimp to gate end enclosure must be == 0,18 um
[2] FIrMP.E.4: Fimp to gate end enclosure must be == 018 um

5. To correct the errors, find the error location by clicking on the error and then clicking on the
right arrow key on ELW. To hide all the errors, click on ‘NV’ (no Layers visible) button.

The particular error in the following figure is due to a lower than 0.18 um enclosure of gate by
Pimp (drw) layer. Stretch the Pimp layer to correct it. Similarly, do this for all errors in your layout.
No one can list all the errors one may commit, try correcting one after another and be familiar with
them by solving them through practice.

After correcting all the errors, run the DRC again.

6. If your design is error free, you should get the following message.

X - o X

6 Mo DRC errors found.
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LVS check by Cadence’s ASSURA

1. Execute Assura-Run LVS. Select gpdk090 and give a Run name.

= Run Assura LVS b4

Schematic Design Source | DFII n Use Existing Metlist J Metlisting Options...
Use Verilog Top Cell

Library mylib Cell  inwerter View  schematic Browse. ..

Layout Design Source DFIl n Use Existing Extracted Metlist J

Library mylih Cell  inwverter| YWiew  Lagyout Erowse..

Run Mame lws2 Run Directory
e

Run Location |ocal n
Wi Rules Fileg ¥  Technology gpok030 n Fule Set |default n

Ll Extract Rules st fcadence /gpdk090_wd. 6 fassurafextract. tul WiEn . Reload
—  Compare Bules  wome/buet/cadence /gpdk090_wd. 6/ assura/conpare. tul WiEny...
Switch Mames et Switches
—  EBinding Filefz)  /home /buetfcadence /qpdk030 +wd. & /assurasbind. rul Wi
— RS5F Include z/buetfcadence fgpdk090_wd | B fassura/AAVsinclude. st WiEn.
Variahle Walue Default Description
EICH -
Yiew avParameters Modify avFarameters... 7 avParameters are set
Yiew avCompareRules bodify avCompareRules.. 1 avCompare rle is set
Yiew sdditional Functions Mo additional functions are set.

m Cancel Apply Defaults Load State Save State Yiew REF Help

Click OK.

2. After completion of lvs run, you will get a result window. If you have done everything right, it
will say that Schematic and Layout match.

Suppose that, you have done a mistake, your schematic says the PMOS width is 480n where layout
says it is 240n. What will happen in LV'S report? Let’s see.
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i autoPinSwap () results for schematic network.

Compare problems were detected in 1 cells
1 cells had parameters mismatches.
0 cells matched

No Extraction Problems were detected.
Tou currently hawve an open run {project).
Press "OE" to close this run and enter the LVS Debug Enwvirorment.

Press "Cancel" to leawe this run open and close this Dialog hox.

LVS Run "lwsl"
is located in /home/fallle 120105001 /fcics

The L¥S run "lwsl" has completed successfully

Frew. Errar Frew. Warn. et YWoarn. Mlext Error
L 7 7 A -

Note that, LVS report says that 1 cell had parameter mismatch. That means one cell had two
different dimensions in schematic and layout. Click OK. ‘LVS Debug’ window will appear:

[£] LVS Debug - s

File “iew Options Tools Help

| X

cadence

Cell List sch || lay) | Exract @ Compare

|
Summary (sch (| 1ay)

INVEL {mylib} I INVEL {my

-~ B
[ .

Dpen Schematic. Cell.. Dpen Layout Cell...

Caer Towl...

q |

3. Select INVX1 (mylib). Notice that summary window shows the list of errors.

Cell List (sch || lay)

| o Exfract @ Compare

I
Summary (sch || lay)

INVEL {mylib} IMVEL {7 Fewires 1]
Hets 1]
Devices 1]
Pins 1]

&
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4. Only parameter mismatch has occurred. Click on Parameters and Open Tool.

|
summary (sch || lay)

Rewires 1]

Hets 1]

Devices 1]

Pins o] o
1

Open Tool... J
5. ‘Parameters mismatch tool” will open.

[€] Parameters Mismatch Tool — O x
File Options  Wiew Tools  Help cadence
schilLay Cells  INVEL {mylih} I INVEL {mylib}
Message

Schematic Info () Layout Info (1)

Mame Mame

PMO pmoslv avDT 1 pmosly

Frioke W) ) Femoge Frofe Wl n ) i B Em oy e
o A o L A A d

10 |

6. Select PMO pmoslv. Now in the Message box, you can see the mismatch error.

SchilLay Cells  INVEL {mylib} I INVEL {mylib}

Message Err: MOS Sch LAWY 1e-07 4. 8e-07; Lay LAW 1e-07 2. 4e-07
schematic Infa (N Layout Info ()

MHame Mame

7. Change the width of PMOS to the value of width in layout and run LVS again. This time you
will get an LVS match.
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X Run: "Is1” — O >

Bum: "Ivs1" from
fhamedfalll 620105007 /i

schematic and Layout Match.

You currently have an open run (project).

Do you wwant to close current project and view the results of new run®
Summary of LV'S [ssues

Extraction Information:

0 cells have 0 mal-formed device problems
0 cells have 0 label short problems

0 cells have 0 label open problems

Comparisan Information:

0 cells have 0 Met mismatches

0 cells have O Device mismatches

0 cells have O Fin mismatches

0 cells have O Farameter mismatches

ELW Information:

Total DRC wiolations: 0

Yes o Help

Parasitic Extraction by Quantus QRC

(In this section, the inverter cell name is given as INVX1, which is inverter in your case)

1. Execute Assura-=>Open Run. Select the final error free Ivs run name in the run name field (it
automatically loads the last Ivs run). Click OK.

X OpenRun — O X

Run Diractory W
—

Run Mame vel n LS Debug Environmert... LS Error Repaort... \ ERLC Erowser.. J

Cancel Help

2. Execute Assura=Run Quantus QRC. Select Extracted View in the output field under Setup
tab.
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— O >
Setup Extraction Filtering rMetlisting Run Details Substrate
Technology (@pdk030 n RuleSet default n a
—  pZlvsset NMOME UserdultRulesets =y
—  Setup Dir ftech/fprocess /qpdk090 fassura/rox -
— Include Command File C‘”_E”ﬂ\_ﬂ't;
Rule Command File Include wﬂ
—  Tech Cmd File |\User T | e\ Edit)
| Library Definitions File  /home /£21116,/120105001 /cic/eds. 1ib w& =
Output  [Extracted View Lib mylik  Cell INVEL  View av_extracted
Enable CellView Check L
Farasitic Res Component presistor Frop Id r
Farasitic Cap Component poapacitor Frop Id =
Farasitic Ind Component pinductor Frop Id 1
Farasitic M Component prind Frop Id k
Inductance L1 Prop |d 1ndl Inductance LZ Prop |d ind2
Farasitic CCVS Component W Hogain Prop Id hng YWref Prop o F
Farasitic W5 Component VSOULce Frod Id v
Call Procedure
Substrate Estract L Substrate Profile MOME n
Add LYS kOS Diffusion Res Extract rMAOS Diffusion Res L bl
HJ_.u_u.:uy OITFCTOLy  SPECITY & UILECTOLY [UL WIITINg [O0Cal [IDTErIET CIEaTeD
during the hierarchical extraction of an extracted wiew.
‘_ Cancel | Apply o Defaults | Load State | Sawve State | View Command File | Help

3. Go to Extraction tab. Select RC as Extraction type and put the name of your reference node
(gnd! in the given case) and click OK.
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setup Extraction Filtetitg rMetlisting Fun Details Substrate
Extraction Type RC n Mame Space Layout Narnes n
e fracture [ength infinite MICrans n Temperature 25,10 C | Edit
Cap Coupling Mode |Decoupled B9  rerrioce gnd!

4. After completion of the run, you will get the following message:

X Quantus QRC Run — O ot

The Guantus GRC run “lvs1" completed successiully
The output is in :

Library: mylik

Cell:  INWH1
Wiew: av_extracted

5. Execute File =2Open and fill in the form as follows. Click OK.

‘}( Open File — O ot
File

. ' Cells
Libirar fylik

L -
Cell THVE1 inwverter
inverter?
WiEny av_extracted n inwerter3
Type layout
Browse
_

Application
Open with ~ Layout L B
_ ahways use this application for this type of file

Open for & edit o read

Library path file  /home/fallle 120105001 cicfcds. 1ikb

\ Cancel . Help

Extracted view will open.
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98_prnosiy’

1
_r r‘r1||r:n_:; 1w

6. Now Launch ADE L from the av_extracted view and setup everything other than outputs to be
plotted in the same way as you have done in Lab 1. After setting everything else, execute
Outputs=>To be plotted - Select on design. Go to av_extracted view. Click on the in pin location
on that view. The following window will appear. Select pin name in and click OK. Do the same for
out pin.

X Select nets/terminals — O *

fin

i)

_Cancel ) _tielp_

Then run the simulation and observe the output waveforms. Then measure power and delay using
waveform calculator.

# Exercise

1. Analyse the effect of parasitic RC elements on the power consumption and propagation delay of
an inverter.
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EEE 4134 VLSI | Laboratory
Lab 5

Schematic Driven Layout of a 2-input NAND gate using Virtuoso Layout Suite
Editor XL

Objectives:
e To be familiar with schematic-driven layout with the example of a 2-input NAND gate.
e To perform Schematic Level Verification, Layout Design, DRC and LVS check and
perform post-layout simulation from extracted view

Creating Layout using Virtuoso Layout Editor XL

1. Virtuoso Layout Editor XL is a schematic-driven layout generation tool. To learn schematic
driven layout we will create the schematic view of a 2-input NAND gate cell which we named
NAND2X1.

2. Instantiate the following cells to your schematic.

Library Name Cell Name | Properties/Comment

gpdk090 nmoslv For NMO and NM1, Width = 240n
gpdk090 pmoslv For PMO and PM1, Width = 480n
analogLib vdd

analogLib gnd

Use your experience from Labl to draw the schematic diagram of the nand gate.

af_nrmesiy
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3. Launch ADE L and simulate the design to verify its functionality. Setup Model library,
Analysis type and Outputs to be plotted as you have done in Lab1l.

While setting inputs for signals A and B, you have to use different periods and delays for the two
signals, so that you can observe all four cases (00, 01, 10, 11) of input signals. Also make sure 0>1
and/or 1->0 transitions for both input signals do not occur at the same time. The following figure
shows a sample of two signals meeting these criteria:

A
I

|
Voltage (B) O I
I
I

-

I
|
|
I
DeIIay Period (B) >I

TimeI(B) |

0

I
|
|
|
|
I
|
I
|
]
I
|
I
|
|
I
|
I

Voltage (A)

<—>I< : >
Delay Period (A)

Time(A) Time

A sample waveform window would look like the following after simulation:

K1 mylib MANDZXT schematic [

Check the functionality of the schematic (whether it acts like a nand gate).
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4. Then create a symbol in the same way you have made symbol of inverter in lab2. Make it look
like a nand gate.

5. In schematic editor window, execute: Launch 2»Layout XL. The following window will appear:

X Startup Option — O >

Fhysical Implementation Startup Options

Layout
& Create Mew . Open Existing

Configuration
— Create Mew . Open Existing

& Automatic
@& el Hep
6. Click OK. ‘New File’ window for layout will appear. Click OK.
X Mew File - O ¥
File
Library mylib B
Cell NANDZE1|
Wienw layout
Type lay out n
Application
Open with Layout xL

_ Abvays use this application for this type of file

Libirary path file
fhome /£all116/120105001 /cic fods. Lib

Gancal )t

‘Virtuoso Layout Editor XL’ window will appear.
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E{};E Virtuese ® Layout Suite XL Editing: mylib NANDZX1 layout

Launch File Edit Yiew Create Yerify Connectivity Options Tools Window  Assura Optimize

O X

»cadence

ok

= & |l%$ |]__-:] Li_l 8 ) ] I:::I |E| | @ »» 3 » L;{ »
A, <3 & 1 EIE|'~.°P| el O] OB My » || F)selectn Selny0 Sely0 Sel(O)a0 |
Palette 7.8 % -
Layers 5%
o Walid _ Used _ Routing
Q -
I vl drawing ﬂ
B4 P a5 RS
Hame | Wis | Sel|
+ =+ -
Layer |[Pu.| V| S|
el drwi w W)=
Owide dry » o
W Oxide_thk drw » o
& Foly dry W W
B Firnp drw v
Objects &)X
[MeSd]
FEFIE
| -
¥ ¥
; v ¥
Ohjects Grids )

Classic n >

23

YTt LY L E
et | GBS B E

»

7. Execute Connectivity > Generate All From Source. The following pop-up window will appear:

X Generate Layout O

Generate 110 Pins PR Boundary Floorplan

Generate

# Instances
_ Chain
IF2 Pins
_ Except Global Pins
__ Except Pad Pins
PR Boundary

__ Shap Boundary

_ Fold

L4

<

Position

Minimum Separation:  0.12] # |n Boundary

Device Correspondence

_ Preserve User-Defined Bindings

Connectivity Extraction

& Extract Connectivity after Generation

s

m . Cancel o\ Defaults_ .
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8. Go to 1/0 pins tab. The dialog box shows that all I/O pins are in Metall layer (Metall drw).
Also put a tick mark on Create label as Label. Click Options. Set Height to 0.1.

X Generate Layout — O x
Generate ¥ Ping PR Boundary Floorplan
Specify Default VYalues for All Fins
Layer: Width:  Height  Mum: Create:

W-t=11  |dow =0.12| 0.1z 1 Apply

Specify Pins to be Generated

Select: Mumber Of Matches: 0 _Add Mew Pin..
Term Mame  Met Mame Layer Width Height MNum Create
"h" "R" ("Metall" “drawing") o1z o1z 1 t
"E" "E" i("Metall" “drawing") o1z o1z 1 t
" e ("Metall" “drawing") o1z o1z 1 t
“grd 1" “gnd !t ("Metall" “drawing") 0.1z 0.1 1 t
“ddl "rddl ("Metall" “drawing") 01z 01z 1 t
Iame: Layer: Width:  Height:  Mum: Create:

N 0.12 | 0.1z | (1 | » | Update
oy

Fin Lahel
& Create Lahel 45 & [Label Ciptions...

e
o Text Display

zancel Diefaults Help

X SetPinlab.. — m| e

Height 0.1

Fant stick n

Click OK, and OK.

9. The initial pin and transistor placement in layout will look like the following:
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10. Execute Options=2Display or Press ‘€’ on keyboard to open ‘Display Options’. Fill it in as
shown:
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K Display Options
Display Controls

Open o Stop Level
REH

€ Ik

Instance Qriging

EIF Surround

Pin Mames

Dot Ping

Met Expressions

__ otretch Handles
Yia Shapes

<

L4

» Dynamic Hilight
» Dragged Ohject Ghost

» True Color Drag
__ Transparent Graup

— Traversed instance BBox _

kaximum Drag Level 32

Mets

sccess Edges
Instance Pins
array lconsg
Lahel Origing
Use True EBox
Cross Cursar
Row Mame
Row Site

Selection Hint

hdaximum Mumber of Drag Figures 500

scrall Percent 25
Instance Drawing Mode

Fath Display

‘EIEIDX

Eorders and Centerlings n

Set LPP Visihility Do not check validity n

Show Mame Of o instance

array Display

& Full Start
— Border
— aSource SO

o

10]

master . both

Display Levels

EEE 4134 VLSI I Sessional

O x
Grid Controls
T¥pe  _ none @ dots o lines
Dim kajor Dots L
hdinor Spacing 0.01
hdajor Spacing 0.1
. Snap Spacing 0.00s
Y Snap Spacing 0.00s
Filter
Size 6 style empty g
Snap Modes
Create (orthogonal n
Edit orthogonal [
Dimiming
Enahle Dimming L
SCDFIE _nune J
Dim Grid Lines

Autamatic Dimming

Drim Intensity:

Dim Selected Ohject Content

True Color Selection anly

& Cellviesy o Library o Tech Library o File « /. cdsenv Browse..
Save To Load Fram Delete From
m _ Cancel | Defaults | Apply | Help

11. The transistors and pins are shown inside a bounding box, which is an estimate of the optimum
size of the final layout. Automatic router will use the bounding box to constrain all routing to occur
within the box. The bounding box may need to be re-sized to accommodate all components. An
important concept to keep in mind during resizing is that standard cells typically have fixed height
(so that power/ground rails line up correctly for routing purposes).

Delete the PR Boundary for now.

Virtuoso Layout Editor XL (VXL) and gpdk090 allow us to create stacked transistors with shared
source/drain areas. Zoom in to two transistors at the bottom (to zoom in, type “z” and draw a box

around the transistors). Click on the transistor on the right and type “m” to move the object. As

you start dragging the object to the left, fly-lines indicating connectivity will appear as shown

below:
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12. When the source/drain areas are overlapped, left-click to fix the position. You should see a
transistor stack with shared source/drain areas like this (depending on how far you move, you may
need to move left/right a bit):

This is a nice NMOS stack for the NAND gate. As you can see, the source/drain contacts have
disappeared. Back to the big picture, zoom to fit (press “f”).
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Let’s do the same exercise for the PMOS transistors. The PMOS transistors in nand gate do have
shared drain contacts because they work in parallel. Connectivity information is extracted from
schematic by VXL. The pull-up network looks like the follwoing:

13. Now, connect different layers using path tool (press ‘p’ on keyboard), and fill areas by drawing
rectangles where necessary (press ‘r’ on keyboard). To connect one layer to another (e.g. Poly to
Metall or Metall to Metal2), create via by pressing ‘0’ on keyboard and selecting proper ‘Via
Defintion’.

X Create Via - O *
hode 2 Single o Stack o Aulo
Cptions | Compute From Shape(s)
Met Name
_ Create as ROD Object Marr vial
Yia Definition M1 _POy n : Standard ¥ia / gpdk020

14. Instantiate M1_PSUB and M1_NWELL cells (that you have created earlier) by pressing ‘i’ on
keyboard and selecting the layout view from library browser.
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X Library Browser - Create Instance — O >

_ Show Categories

Library Cell View

mmlib BT MAWELL laspout

analogLib EES ‘h.r'lew ~| Lock | Size
auTech T — T E—TT
hasic k41 PSLIB

cdsbefTechLib MAMNDEZX1

gpdk04s inverter

gpdk0ao inverterz

gpdki1a0 inverter3d

sample

stdcell

15. Wire up the layout. When you do so, you may encounter multiple options for certain pins. For
example, when you select the PMOS to connect its source to VDD, there are multiple Metall wires
in the PMOS. The desired path will be highlighted and you’ll see the fly-line. Continue until you
finish routing all the signals. Move vdd! and gnd! pins to the power rails. As you are moving the
pins around, notice the fly-lines that indicate the connections.

A practice that you can follow while wiring is to use Metall for all vertical wiring and Metal2 for
all horizontal wiring inside the cell.
Also make the cell height 5 pm.

16. Your final layout will look something like the following:
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17. Perform DRC, LVS and QRC for NAND2X1 as you have done in Lab 4. Generate
av_extracted view and simulate the circuit from that view to verify the functionality.

# Exercises

1. Analyse the difference between stacked and unstacked transistors in post-layout simulation and
explain why we should stack transistors with common drain/source terminals.
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EEE 4134 VLSI | Laboratory
Lab 6

Introduction to Hierarchical Design (2-input AND gate using 2-input NAND
gate and an inverter)

Objectives:
e To be familiar with concept of hierarchical design
e To perform Schematic Level Verification, Layout Design, DRC and LVS check
e To perform post-layout simulation of top level design

Introduction to Hierarchical Design

By this time, you should have completed layout of INVX1 and NAND2X1. Now, you will learn how
to perform hierarchical design. (cell INVX1 in this section is inverter in your case)

1. Create a new cellview of type schematic named AND2X1.

2. Instantiate NAND2X1 and INVX1 symbol from your library mylib in that schematic.
Your final schematic should look something like the following:

3. Now make a symbol of AND2X1.

AHD2K1

4. Now create a new cellview named AND2X1 _test, instantiate AND2X1 and vdd in that cell and the
final schematic should look like the following:
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AMOZHT

5. Now, launch ADE L, setup Stimuli, Model library, Analysis type and Outputs to be plotted in
the same way as you have done in Lab 5. Run the simulation.

F1 mylib 4MD2X1_test schematic £

00 20 40 60 &80 100 120 140 10 180 200 260 28.0 200 320 340 360 380 400 420 440 460

6. If functional verification is okay, then execute Launch-Layout XL from the schematic of
AND2X1.

7. Follow procedure of Lab 5 to generate instances and set display options. You will get something
like the following:
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8. Connect them as required and the final layout should look like the following (probably better!):
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9. Perform DRC, LVS and QRC as you have done in Lab 4 and Lab 5.
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EEE 4134 VLSI | Laboratory
Lab 7

Introduction to Verilog HDL and Quartus |1

Objectives:

e To get familiar with Quartus Il
e To get introduced to Hardware Description Language (HDL)
e To understand behavioral and structural Verilog descriptions

Verilog HDL

A hardware description language (HDL) is similar to a typical computer programming language
except that an HDL is used to describe hardware rather than a program to be executed on a
computer. Two HDLs are IEEE standards: Verilog HDL and VHDL (Very High Speed Integrated
Circuit Hardware Description Language).

Creating a New Project

1. Run Quartus Il by clicking on the shortcut icon on desktop named Quartus Il 9.0spl Web
Edition. A getting started window may open up. You may put a tick on ‘Don’t show this screen
again’, if you do not want this to appear again.

2. Each logic circuit or sub-circuit being designed with Quartus 11 software is called a project. The
software works on one project at a time and keeps all the information for that project in s single
directory (folder) in the file system. To begin a new logic circuit design, the first step is to create a
directory to hold its files. Create a folder in D:\, E:\ or F:\ drive named after your student ID.
Execute File New Project Wizard.

3. In the following window, change the working directory of the project to your directory (e.g.
D:\120105001) and give a name to the project as shown. Note that the project must have a name,
which is usually the same as the top-level design entity that will be included in the project.
Click Next.
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New Project Wizard: Directory, Name, Top-Level Entity [page 1 of 5] l&J
What is the working directory for this project?
lD:\VeriIog
What is the name of this project?
lmux_2l01|

What is the name of the top-level design entity for this project? This name is case sensitive and must ||
exactly match the entity name in the design file.

lmux_2101

Use Existing Project Settings ...

< Back I Next > I Finish | Cancel l

4. We can specify any existing file to be included in the project, if we want, in the next window.
But we will skip it for now. Click Next on the next three windows that open up. Then in the last
window, click Finish.

Creating a new Verilog HDL file under a project (Design Entry), Compilation
and Simulation

1. Execute File >New. A window will open up. Select Verilog HDL File and click OK.

2. The following Text Editor Window will open up and you can write your Verilog code in here
and save it using the same name as the project.

3@° Yerilogl.v I

1

< n »

3. Write your Verilog code. This example shows Verilog code for a 2tol MUX.
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3 mux_2tol.v I &> Compilation Report - Flow Summe

@ i Emodule mux 2tol(A,B,5,Y):;
2 input A,B,S:;

dh 27 3 output ¥Y;

4 assign Y=(S&B) | (~5&A4);

’ S endmodule
is &= 8
A4 %
4 %

The syntax of Verilog code is sometimes difficult for a designer to remember. To help with the
issue, the Text Editor provides a collection of Verilog templates. The templates provides examples
of various types of Verilog statements, such as a module declaration, an always block, and
assignment statements. It is worthwhile to browse through the templates by selecting Edit=>Insert
Template 2Verilog HDL to become familiar with this resource.

4. Click on the purple play button to start compilation of your Verilog code.
XG0P EI»: o MG h (@0 2e

5. After successful compilation, you will get the following message. Ignore the Warnings for now.
Click OK.

Quartus I @

|0I Full Compilation was successful (5 warnings)

If the compiler does not report zero errors, then there is at least one mistake in Verilog code. In this
case, a message corresponding to each error found will be displayed in the Messages window.
Double-clicking on an error message will highlight the statement which is affected by the error, in
the Verilog code in the Text Editor window. The user can obtain more information about a specific
error by selecting the error and pressing the F1 function key. Correct the error and recompile the
design.

6. Now, execute File 2New to create a vector waveform file which is required for simulating inputs
and outputs. Select Vector Waveform File from the list and click OK.

7. The following window will open up.
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Master Time Bar: 15.075 ns v/ Painter: | Ops Interval: | -15.08 ns Start: | End:|

ps 100ns 2D.P ns 300ns

15.075ns
A

e Value at
15.08ns

< U O NTT

8. Double-click on the white space under ‘Name|Value at 15.08 ns’. Or Right-click on that space
and select Insert=>Insert Node or Bus.

9. In the ‘Insert Node or Bus’ window, click Node Finder.

Insert Node or Bus

e
Name: l| oK I
Tupe: [INPUT | Cancel
Value type: IS-LeveI L] Node Finder...
Radix |asc ~]
Bus width: l"
Start index: IU
™ Display gray code count as binary count

10. In the ‘Node Finder’ window, Click List. Make sure ‘Pins:all’ is selected under ‘Filter’.

11. Now the window will look like the following one. Click on the >>’ Button.
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bNode Fir;;er # m
- f S—

oK |

Cancel I

Named: l” ;I Filter: lPins: all ;' Customize... | List '
Look in: LI _J ¥ Include subentities Stop | j
Nodes Found: Selected Nodes:
| Name I Assighments J 3 Name J Assignments I ]
| 4, Unassigned |
BB Unassigned |
i S Unassigned |
oY Unassigned  (
]|
' >
, ]
' [=]
‘ << I
|
| |
]« N - ’ {lm i, - »

12. Now, it should appear like the following. Click OK.

e e {1# (oo
- T —

Named: I" 3 Filter: lPins: all z] Customize... I List | @ OK |
Look in: |[EEESEE ;‘ _J IV Include subentities Stop | Cancel I
Nodes Found: Selected Nodes:
I Name I Assignments l i Name I Assighments I i
| A Unassigned | 8 [mux_2to1]A Unassigned |
B Unassigned | 9 [mux_2tal|B Unassigned |
[ [ Unassigned | 9 [mux_2to1(S Unassigned |
| =y Unassigned L [mux_2tollY Unassigned  (
=
|
' < |
' << |
|
; |
|
[ |« i ] » < - »
7|

13. In the following window, click OK.

Page 89



EEE 4134 VLSI I Sessional

Insert Node or Bus

Name:

Type: I “Multiple ltems™* EI Cancel l
Value type: | FLevel v IW'
Radix: |ascn ]

Bus width: I1

Start index: IU

™ Display gray code count as binary count

IS
l’“MuItipIe Items™* oK l

14. The vector waveform file will now look like the following:

==
h A
*® @

Ar
(”’n

X %

LU |
-~

ar

| Master Time Bar: 15075 ns «| *| Pointer: Ops Interval: -15.08 ns Stat
ps 100ns 200ns
Vdue at Ll ()
Name | 1508ns 15.075ns
|
0 A AD
w1 E AO
2 ) AD
o»3 Y AX

Now, you can clearly see the inputs and outputs.

15. Select an input and from the left palette, click on the ‘Overwrite clock’ icon.

% 4l

s

16. In the ‘Clock’ window, set parameters of the clock.
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Clock [
— Time range
Start time: {U lps Zl
End time: I1.U ]us L’
i~ Base waveform on
@
" Time period:
Period:  [10.0 [ns _v_l
Offset.  [0.0 Ins v

Duty cycle (%): 150 ;1

oK | Cancel |

17. Now, after setting all the input clocks, Vector Waveform File will look like the following.
Note that, the output Y is displayed as having an unknown value at that time, which is indicated by
a hashed pattern; its value will be determined during simulation.

@ Master Time Bar: 15.075 ns «| »| Pointer: 500 ps Interval: -14.58 ns Start: End:
k A o Value at ps 10.[0 ns S ZO.p ns BO.P ns 40.9 ns SD.p ns 80.9 ns
15.08 ns -U/ons
CCN 4
g (=] A Al | | | | | | J | J | l_
o w1 B Al

# b [H2 s A0 | |

Fed op 3 Y AX W&%&%& SRR RER R R R R R R R R R R R R R R R R R RERERELRERERERERERELREREERERE
% 4

4 T m

18. Save the Vector Waveform File. It must have the same name as the Verilog file.

19. A designed circuit can be simulated in two ways. The simplest way is to assume that there is no
delay in propagation of signals through the circuit. This is called functional simulation. A more
complex way is to take all propagation delays into account, which leads to timing simulation.
Typically, functional simulation is used to verify the functional correctness of a circuit as it is being
designed. This takes much less time, because the simulation can be performed simply by using the
logic expressions that define the circuit.

Click on the blue play button and you should observe the simulated waveforms.
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Mrewe v rwnoo[E]e ® 2o

Simulation Waveforms
Simulation mode: Timing
‘ [% Master Time Bar: | 15.075 ns | Pointer: | Interval: Start: End:
A (e ps 10.9 ns 20'.0 ns 30.9 ns 40.9 ns 509 ns 60.9 ns
ey Name 15.08 ns 150715 ns
@‘ 0 A Al | [ [ J [ J | J | J |
By (w1 B Al g F
; ™y o2 S AD | |
n 23 Y AT | | | [ | | | r
4
_’
(oo,
[ B
2l
< L [ T

Note there is a delay between input and outputs which simulates the real effect of gate delays. If
you are interested in only functional analysis rather than timing analysis, go through some more
steps.

20. Execute Processing =>Simulator Tool.

21. In the following window, select Functional as Simulation Mode and click on Generate
Functional Simulation Netlist.

£B Simulator Tool fol-@ 3]
Simulation mode: | Functional ~] Generate Functional Simulation Netist |
Simulation input: ~[mux_2o1. vt ... | AddMuliple Fies... |

22. After generating functional simulation netlist, the following window will appear. Click OK.

Quartus I @

| Functional Simulation Netlist Generation was successful (6 warnings)

OK

B

23. Click on the blue play button and you should observe the following message.

Ms@we 0> v wo[E]e @2 0|
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Quartus I @

| Simulator was successful

24. Now observe the simulation waveforms from Processing 2Simulation Report, and note that
there is no time delay between inputs and output and the function of this code is indeed that of a
2tol MUX.

Simulation Waveforms

Simulation mode: Functional
[ [} Master Time Bar: 15075ns <) | Painter 153 ns Interval 1355ns  Stat ‘ ' End: \

A Vakue at ps 10.9 ns 20.9 ns 30.9 ns 4D.P ns 51).9 ns 60.9 n
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1. Which ones of the following identifier names are incorrect according to Verilog syntax?
2tolMUX, MUX$2tol, mux 2tol, reg, reg4bit, 130105 counter

2. What are the differences between ‘structural’ and ‘behavioral’ Verilog codes? Show an
example of each for a particular logic circuit.
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EEE 4134 VLSI | Laboratory
Lab 8

Combinational Logic circuit design in Verilog HDL using Quartus Il

Objectives:

e To design combinational circuits with Verilog codes, and verify the codes through
simulation
e To learn about hierarchical design using Verilog HDL

Verilog codes for combinational logic circuits

Half-Adder

module half adder (A,B,Cout,S);
input A, B;

output S, Cout;

assign S = A"B;

assign Cout = A&B;

endmodule

2-to-1 MUX

module mux2l fn(IO0,Il1,S,f);
input I10,1I1,S;
output reg f£;
always@ (I0,I1,5S)
begin

if (S == 0)

f = I0;

else

f =1I1;

end

endmodule

Priority Encoder

module priority (W, Y, z);
input [3:0]W;

output reg [1:0]Y;

output reg z;

always @ (W)

begin

z = 1;
casex (W)
4"pblxxx:
4"p01lxx:
4'"p001x:
4'p0001:
default: begin
z = 0;

Y = 2'bx;

end

endcase

end

endmodule
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Full Adder using Half-Adders

module FA 001 (A,B,C,Cout,S);
input A,B,C;

output Cout, S;

wire C1,C2,S1;

HA 001 f1(A, B, Cl1, s1);
HA 001 f2(s1, C, C2, S);
assign Cout = Cl|C2;
endmodule

module HA 001 (a,b,c,s);
input a,b;

output ¢, s;

assign c = aé&b;

assign s = a"b;
endmodule

2-to-4 Decoder

module dec2tod4 (W, En, Y);
input [1:0]W;

input En;

output reg [0:3]Y;

integer k;

always@ (W, En)

for(k = 0; k < = 3; k = k+1)
if ((W == k) && (En == 1))
Y[k] = 1;

else

Y[k] = 0;

endmodule

Page 95



EEE 4134 VLSI I Sessional

# Exercises

1. Explain the differences between ‘concurrent’ and ‘procedural’ statements? Show an example of

each.

2. Examine whether the following two code segments will yield different outputs. Explain your

reasoning.

always@ (w0 ,wl,s) always@*
begin begin
if (s==0) if (s==0)
begin begin
f=w0; f=wO0;
end end
else else
begin begin
f=wl; f=wl;
end end
end

3. Read the following Verilog code and find out what it does. State your reasoning.

module ques4 (w,y);
input [3:0]w;
output reg [1:0]y;

always@ (w)
begin
casex (w)
‘b1000:y=3;
‘bx100:y=2;
‘bxx10:y=1;
default:y=0;
endcase
end
endmodule

4. Write Verilog codes for-

a) BCD Adder

b) 4-to-1 MUX using 2-to-1 MUX

c) 8-to-1 MUX using 4-to-1 MUX, 8-to-1 MUX using 2-to-1 MUX
d) 16-to-1 MUX using 8-to-1 MUX, 16-to-1 MUX using 4-to-1 MUX
e) 4-bit comparator

f) 4-bit Full-Adder using 1-bit Full-Adder modules

g) 4-bit adder/subtractor

h) 4-bit Arithmetic logic unit (ALU) with 8 functions
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EEE 4134 VLSI | Laboratory
Lab 9

RTL synthesis and Sequential Logic Circuit design in Verilog HDL using
Quartus 11

Objectives:

e To get familiar with RTL Synthesis in Quartus 11
e To design sequential logic circuits in Verilog HDL, and verify the codes through simulation

RTL Synthesis in Quartus Il

Logic synthesis is a process by which an abstract form of desired circuit behavior), is turned into a
design implementation in terms of logic gates, by a synthesis tool. Common examples of this
process include synthesis of HDLs, including VHDL and Verilog. Some synthesis tools
generate bit-streams for programmable logic devices such as PALs or FPGAs, while others target
the creation of ASICs. Logic synthesis is one aspect of electronic design automation.

In digital circuit design, register-transfer level (RTL) is a design abstraction which models
a synchronous digital circuit in terms of the flow of digital signals (data) between hardware
registers, and the logical operations performed on those signals. Register-transfer-level abstraction
is used in hardware description languages (HDLs) to create high-level representations of a circuit,
from which lower-level representations and ultimately actual wiring can be derived.

1. Write Verilog code for a logic circuit, compile it and verify its functionality through simulation.

Suppose, you have completed all these steps for Verilog code of a half-adder.

1 BEmnodule halfadder (A,B,Cout,5):
2 input A, B;

3 output 5, Cout:

4 as=sign 5 = A"B;

5 as=zign Cout = A&B;

6 endmodule

-

Then you can proceed to obtain RTL view for this logic circuit.
2. Execute Tools >Netlist Viewers 2RTL Viewer. A window will appear and you can see the RTL
view.

Cout~0

Al

I
E

As you can see, this is the logic circuit for a half-adder.
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Verilog codes for sequential logic circuits

Latch

module latchOl (D, clk,Q);
input D, clk;

output reg O;
always@ (D, clk)

if (clk)

0=D;

endmodule

Flip-flop

module flipflop (D, Clock, Q) ;
input D,Clock;

output reg O;

always(@ (posedge Clock)
Q<=D;

endmodule

Shift Register

module shift3(w,Clock,Q);
input w,Clock;

output reg [1:3]0Q;
always(@ (posedge Clock)
begin

Q[3]<=w;

Q[2]<=QI[3];

Ql1]<=QI[2];

end

endmodule

Counter

module count4 (Clock,Resetn,E,Q);

input Clock,Resetn, E;
output reg [3:0]0Q;

always(@ (posedge Clock, negedge Resetn)

if (Resetn==0)
0<=0;

else if (E)
0<=0+1;
endmodule
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# Exercises

1. Evaluate out the function of following logic circuit and write a Verilog code to obtain the same
logic circuit in ‘RTL Viewer’.

Q-0 Q~regl
=T O = -
TI D @ Q
Q-1 Q-2

clk|

2. Write Verilog codes for a 4-bit up/down counter, which counts up if select pin=0 and counts
down if select pin=1.

3. Write Verilog code for a universal shift register which can shift left/right and can load data both
in parallel mode and serial mode.

4. Write Verilog code for a J-K flip-flop using D flip-flop and a T flip-flop using J-K flip-flop.

5. Synthesize already written Verilog codes to obtain RTL diagrams.

6. Write the Verilog code for a logic circuit which counts to 3 if selection input (composed of 2
bits) §,S, = 01, counts to 7 if S, S, = 10, counts to 15 if S, S, = 11. If S, S, = 00, then it halts
counting. Use positive edge-triggered counter.

7. Explain the differences between ‘synchronous’ and ‘asynchronous’ resettable flip-flops?

8. Find 10 mistakes in the following Verilog code which implements a 5-bit shift register:

module 8ques (w,clk,Q)
Parameter n=5;

input w,clk

output [n-1:1]qg;

always@ (posedge clk) ;

begin
q[5]=w;
ql4]1=q[5];
ql3]=ql4];
ql2]=q[3];
qlll=q[2];

end

end

9. Explain the differences between ‘blocking’ and ‘non-blocking’ assignments with examples.

Page 99




EEE 4134 VLSI I Sessional

References and Further Readings

1. CMOS VLSI Design: A Circuits and Systems Perspective (4th Edition)

by Neil Weste, David Harris

2. Fundamentals of Digital Logic with Verilog Design (3rd Edition)

by Stephen Brown, Zvonko Vranesic

3. Physical Design Essentials: An ASIC Design Implementation Perspective

By Khosrow Golshan

4. Digital VLSI Chip Design with Cadence and Synopsys CAD tools

by Erik Brunvand

5. Fully custom design tutorials of EEE Department, Hong Kong University

6. VLSI | and 1l Lab Manuals of EEE Department, Bangladesh University of Engineering and
Technology (BUET)

7. Custom IC Design Manual provided by University Support Team, Cadence® Design Systems,
Bangalore, India

Page 100


https://www.amazon.com/s/ref=dp_byline_sr_book_1?ie=UTF8&text=Neil+Weste&search-alias=books&field-author=Neil+Weste&sort=relevancerank
https://www.amazon.com/s/ref=dp_byline_sr_book_2?ie=UTF8&text=David+Harris&search-alias=books&field-author=David+Harris&sort=relevancerank
https://www.amazon.com/s/ref=dp_byline_sr_book_1?ie=UTF8&text=Stephen+Brown&search-alias=books&field-author=Stephen+Brown&sort=relevancerank
https://www.amazon.com/s/ref=dp_byline_sr_book_2?ie=UTF8&text=Zvonko+Vranesic&search-alias=books&field-author=Zvonko+Vranesic&sort=relevancerank

	manual cover
	EEE 4134 lab manual REVISED

